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About This 
Manual 

How to Use This 
Manual 

This manual introduces you to CatalysFM, the mouse­
based program selector for the Apple® II and high­
capacity disk drives. 

The manual tells you how to: 

o Start up Catalyst on a UniDiskTM 3.5 or Disk II 
(Chapter 1) 

o Use Catalyst with a mouse (Chapter 2) , or without 
a mouse connected (Chapter 3) 

o Install and run programs with Catalyst (Chapter 4) 

Chapter 5 contains reference material on disk drives 
and memory. Chapter 6 is a reference for the 
Catalyst desktop and menus. 

The appendixes contain information you'll need only 
in certain circumstances. If you have only a UniDisk 
3.5 connected to your Apple II, you may not have any 
information on how to use the System Utilities 
program: see Appendix A. If you have custom 
programs that you want to add to Catalyst, see 
Appendix B. If you have questions about seNice and 
product revisions, see Appendix C. 

Be sure you have read your owner's manual, used 
your training disks, and connected all your 
equipment before you use Catalyst. 

Read Chapter 1 to learn how to start up Catalyst. 
Use Chapter 2 (mouse) or Chapter 3 (mouseless) to 
find out how to move around in Catalyst. Then use 
Chapter 4 to learn how to install and run your 
programs with Catalyst. Use the rest of the manual 
for reference as you need it. 

Now turn to Chapter 1 and get started. 
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Chapter 1: 

Introduction 
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Introduction 

What Is Catalyst? 

This chapter explains what Catalyst is, what 
equipment you need, and how to start up Catalyst. 

Before you continue, take time to fill out and return 
your Catalyst warranty registration card. It is a tear­
out card at the back of the manual. Quark offers free 
technical support to registered Catalyst owners only. 
To become a registered owner you must return the 
card. 

Catalyst is a mouse-based program selector. 
Catalyst gives you easy access to your programs 
from a single disk. You can 

o Copy (install) the programs you use frequently 
onto a high-capacity disk 

o Switch between your programs with the click of a 
mouse 

o Automatically run the program you select 

o Use desktop accessories, like Calculator, Change 
Desktop, and Puzzle 

o Manage your disks on the desktop 

The Catalyst desktop shows you images, called 
icons, of all the disks you have in your drives and all 
the programs on each disk. The menu bar at the 
top of the desktop gives you menus of the Catalyst 
commands you use to manage disks and 
programs. 

When you start up a program from Catalyst, you 
leave the desktop and use the commands and 
features of the program you have selected. When 
you quit the program, you return to the Catalyst 
desktop. 
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Equipment 
You Need 

Hardware-Related 
Equipment 

All Catalyst users need 

• The Catalyst Master and Backup disks 

• A high-capacity disk drive (UniDisk 3.5 or a hard disk like 
OC1 OTM, OC20™, or ProFile™) 

• At least one blank formatted disk (don't name it "CATALYST") 

A mouse is desirable, but optional. 

Using a mouse increases your productivity and lets you take 
full advantage of the desktop icons in Catalyst. If you don't 
have a mouse, you use menu commands and key 
combinations to move around the screen and work with the 
icons. 

The other equipment you need depends on which computer 
you are using. 

Apple lie users need 

128K of memory 

• An Extended 80-Column Text Card with the double Hi­
Resolution jumper installed 

See your Extended 80-Column Text Card Manual for 
installation instructions. 

• An Apple lie ROM Enhancement installed 

Your Apple lie may contain the correct ROM chips already. 
Catalyst informs you if you need an enhanced lie. Your 
dealer can install the enhancement for you. 

Apple lie users with a UniDisk 3.5 need 

• An Apple IIc ROM Upgrade installed 

Your Apple IIc probably contains the correct ROM chips, 
since the UniDisk won't work if you don't have the ROM 
upgrade. If you need an upgrade, your dealer can install it for 
you. 
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Starting Up 

Catalyst on a UniDisk 
3.5: Apple lie Users 

Catalyst on a UniDisk 
3.5: Apple IIc Users 

Starting up Catalyst is a simple process. Follow the steps for the 
disk drive and Apple II you are using. 

If you have an Apple lie you'll be asked if you have a mouse. If 
you have an Apple lie, yourcomputerwill determine whether or 
not you have a mouse connected, and won't ask you. 

1. Make sure the UniDisk 3.5 interface card is installed in a slot 
with a higher number than the slots containing cards for your 
other disk drives (Disk II, hard disk drives, or RAM disk) . 

Your Apple reads information from interface cards beginning 
with the highest numbered slot. Apple recommends that the 
UniDisk 3.5 card be in slot 6, a hard disk (if you have one) in 
slot 5, and the Disk II Controller card in slot 4. For more 
information, see "Connecting Your UniDisk 3.5 to an Apple 
lie" in the UniDisk 3.5 Owner's Manual. 

2. Insert the Catalyst Master disk in the UniDisk 3.5. 

3. Turn on the monitor and the computer. 

If your computer is already on, restart it by pressing and 
holding the OPEN APPLE and CONTROL keys while you 
press and release the RESET key. Then release the OPEN 
APPLE and CONTROL keys. 

1. Make sure there is no disk in the built-in drive. 

2. Insert the Catalyst Masterdisk in the UniDisk 3.5. 

3. Turn on the monitor and the computer. 

If your computer is already on, restart it by pressing and 
holding the OPEN APPLE and CONTROL keys while you 
press and release the RESET key. Then release the OPEN 
APPLE and CONTROL keys. 

You see 

Do you have a mouse? 
(Type Y or N or click the mouse.) 

Respond appropriately to the prompt. 
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Catalyst on a Disk II 
Floppy Disk: Apple lie 
and Apple lie Users 

The Catalyst 
Desktop 

1. Insert the Catalyst Master disk in the built-in drive or drive 1. 

2. Turn on the monitor and the computer. 

If your computer is already on, restart it by pressing and 
holding the OPEN APPLE and CONTROL keys while you 
press and release the RESET key. Then release the OPEN 
APPLE and CONTROL keys. 

If you have an Apple Ilc, you see 

Do you have a mouse? 
(Type Y or N or click the mouse.) 

Respond appropriately to the prompt. 

When you start up Catalyst, your screen looks like this: 

MenuBar----------------~~.-LFi~le~Ed~it~M~isc~e~lIa~ne~ou~s----------__________ -1 

Pointer -------------------11-111---~ 
Catalyst Disk Icon __________ -+ ......... _______________________ _ __ _ 

Catalyst Desktop __________ ---'1-11--_____________ _ 

Trash Icon _ _ ____ -+ ___ - ------------ 1 
Ir Ol h 

This is the Catalyst desktop. It is Catalyst's working 
environment: the central organizing area you use to move, copy, 
install, change information about , and remove your disks and 
programs. 

The bar at the top of the screen contains menus you choose 
from. You'll find out how to use menus in Chapter 2 if you have a 
mouse, or in Chapter 3 if you don't have a mouse. 

The pOinter marks your place on the screen. 
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Moving On 

The gray area contains icons that let you know what is available . 
When you start up you see icons that represent: 

• the Catalyst Master disk you started up with 

• the Trash, where you can discard what you don't need 
anymore 

You may also see icons for other disks. 

If your screen doesn't look like this, someone else has probably 
used Catalyst and arranged the desktop in a different way. Press 
CONTROL-C until all you see on your desktop is icons. 

If you have a mouse, go on to Chapter 2 to find out how to use it. 
Then proceed to Chapter 4 to put Catalyst to work. 

If you don't have a mouse, go to Chapter 3 to find out how to get 
around in Catalyst without one. Then proceed to Chapter 4 to 
put Catalyst to work. 
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Chapter 2: 

Moving Around in Catalyst 
With a Mouse 
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I ntrod uction This chapter explains how to move around in 
Catalyst with a mouse. It describes moving the 
mouse, using the menu bar and dialog boxes, and 
working with windows. 

The first part of the chapter is a step by step tutorial. 
It describes four mouse terms you need to be familiar 
with and guides you in learning how to move the 
mouse. 

The remainder of the chapter provides background 
on using menus and windows, and summarizes how 
to use the mouse to perform particular operations. 

If you don't have a mouse connected, use Chapter 3 
instead of this one. It explains the menu commands, 
keystrokes, and keyboard equivalents for mouse 
operations. 

When you are comfortable with using a mouse, go 
on to Chapter 4, "Putting Catalyst to Work." 
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Using a 
Mouse: 
Tutorial 

Moving the Pointer 

You can start up programs, move icons, choose from menus, 
work with windows, and accomplish other Catalyst tasks with a 
mouse. 

When you use a mouse you combine two simple actions: moving 
it on a flat surface and pressing the mouse button. Varieties of 
moving and pressing actions are described by these terms: 

Select means to position the pointer on an item and press 
and release the mouse button once. 

Click means to press and release the mouse button once. 

Double-click means to position the pointer on an item, and 
press and release the mouse button twice in quick 
succession to select and open the item. 

Drag means to position the pointer on an item, press and 
hold the mouse button as you move the mouse, and release 
the button when you have moved the item to a new place. 

Once you learn to manipulate the mouse in these four ways, you 
have all the tools you need to move around in Catalyst with a 
mouse. 

The pointer marks your place on the screen. You move the 
pointer by rolling the mouse on a flat surface. 

The pointer's shape depends on what you are doing. Usually it 
is shaped like an arrow. The pointer becomes a watch when 
Catalyst is doing something that takes a little time, and an 1-
beam when it is positioned in an editing area. 

To try moving the pointer: 

1. Roll the mouse on a flat surface to move the pointer. 

2. L~t the mouse and reposition it when you run out of room to 
move the mouse. (Lifting the mouse doesn't move the 
pointer; the pointer only moves when you roll the mouse.) 
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Selecting by Clicking 

Dragging 

Selecting means to position the pointer on an item and press 
and release (click) the mouse button once. Selecting an icon or 
window with the mouse indicates where you want the next actio n 
to take place, and changes the selected ITem. 

• Selecting a disk or program icon makes IT dark. 

Selecting a window activates it and brings it to the front. 

• Selecting a close box closes its window. 

• Selecting a program icon in a RAM disk window makes it 
white. 

Note: You cannot edit the name of an icon simply by selecting it 
as you can on the Macintosh™ desktop. See Chapter 6, 
"Catalyst Reference," for renaming instructions. 

To try selecting by clicking: 

1. PosITion the pointer on the trash icon. 

2. Press and release the mouse button once to select the trash. 

3. Move the pointer from the trash icon to the Catalyst disk icon 
and click (press and release) the mouse button once to select 
the Catalyst icon. 

Notice that when you select the trash icon, it becomes dark 
(highlighted) . When you move the pointer to the Catalyst icon 
and click again, the trash icon becomes white and the Catalyst 
icon becomes dark. 

Dragging means to position the pointer on an ITem, press and 
hold the mouse button as you move the mouse, and release the 
button when you have moved the item to a new place. 

Dragging selects an ITem and moves it to the place on the screen 
where you release the mouse button. 

• When you drag a program icon from one window to another, 
Catalyst makes a copy of the program. 

• When you drag a program icon onto the trash, the program is 
removed from the disk it was stored on. 
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Opening by Double­
Clicking 

• When you drag a disk icon, it moves. (You can't copy a disk 
by dragging its icon as you can on a Macintosh. Use Quick 
Copy instead.) 

• When you drag a Disk II or UniDisk 3.5 icon onto the trash, 
Catalyst removes the disk contents from memory. A UniDisk 
3.5 disk is also ejected if you drag its icon onto the trash. 

• When you drag on a menu, you move the pointer through 
the commands. 

To try dragging: 

1. Position the pointer on the Catalyst icon. 

2. Press and hold down the mouse button while you move the 
mouse to the left. 

Watch an outline of the icon move across the screen as you 
move the mouse. 

3. Release the mouse button. 

Watch the icon image move to the new position and fill the 
outline. 

4. Press and hold down the mouse button while you drag the 
icon outline back to the upper right corner of the screen. 

5. Release the mouse button to reposition the icon. 

Notice that the icon image moves to the new position and fills the 
outline as soon as you release the mouse button. 

Double-clicking means to position the pointer on an item, and 
press and release the mouse button twice in quick succession. 

Double-clicking selects the item and opens it. When you open a 
disk icon, you see it's contents in a window. When you open a 
program icon, the program is started up by Catalyst. 

To try opening by double-clicking: 

1. Position the pointer on the Catalyst icon. 

2. Press and release the mouse button twice in quick 
succession to double-click (select and open) the icon. 
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Using the Trash Icon 

You'll see the contents of the Catalyst disk in a window. Each of 
the icons in the window represents a program. Double-clicking 
on one of the program icons (don't do it now) will start up the 
program. 

If a disk window is already open when you double-click its icon, 
the double-click brings the window to the front. 

• File Edit Miscellaneous 

IQI JS.~Q] 

I 
I rorh 

The trash icon is there for you to discard things. It should be 
used with caution. Here's how it works: 

• When you drag a program icon into the trash, Catalyst asks if 
it's OK to throwaway, and then removes the program from the 
disk on which it resides. 

• When you drag a disk icon into the trash, Catalyst removes 
the disk contents from the computer's memory. 

• When you drag a UniDisk 3.5 disk icon into the trash, Catalyst 
removes the disk contents from the computer's memory and 
ejects the disk. 

Note: There are two menu alternatives to using the trash. 
Discard Disk ... removes a disk from the desktop. Delete 
Program ... removes a program from a disk. The next section, 
"Using the Menu Bar," explains how to select from the menu. 
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Using the 
Menu Bar 

To try using the trash: 

1. Drag the Catalyst disk icon (select it, then press and hold the 
mouse button while you move the icon) onto the trash icon. 

When the trash icon is darkened, release the mouse button 
and the Catalyst icon will disappear. Putting it into the trash 
has removed the contents of the Catalyst disk from the 
computer's memory. 

2. If your Catalyst is on a 3.S-inch disk, reinsert the disk to put 
Catalyst back on the desktop. 

or 

If your Catalyst is on a floppy disk, press OPEN APPLE-S. 
Then press RETURN or click OK. This puts Catalyst back on 
the desktop. (You'll find out more about the Switch Disks 
command in Chapters 4 and 5.) 

• File Edit Miscellaneous 

You choose a command from the Catalyst menu bar with the 
mouse to tell your Apple II what you want to do. 

All the commands available to you on a menu are black. Those 
you can't use are gray (dimmed). An ellipsis ( ... ) following a 
command indicates that you'll have further choices to make after 
selecting that command. 

26 Chapter 2: Moving Around in Catalyst With a Mouse 



Keyboard equivalents (keystrokes you can use instead of pulling 
down the menu) are indicated by a • or + and a letter next to the 
menu commands. You can see examples of both of these on 
the File menu . 

• represents the OPEN APPLE or SOLID APPLE key. To use 
the keyboard equivalent instead of choosing from the menu, you 
press and hold one of the Apple keys and then press the 
indicated letter . 

• represents the CONTROL key. To use the keyboard 
equivalent instead of choosing from the menu, you press and 
hold the CONTROL key and then press the indicated letter. 

This section explains how to use the menu bar with a mouse. For 
more information on each of the Catalyst menus and specific 
menu commands, see Chapter 6, "Catalyst Reference." 

Menu Bar ________ +-__ 

Ell ipsis ---------t-l~=1=:;;==;:::::/:...··-·-~ =I---'-'-A--AI4 

Keyboard Equivalent - ___ ~I-II-+-I=:===T--:: I 

Menu _________ ~~~I-----·--- ------·----··Ir' 

To View a Menu Posijion the pointer on the title of the menu you want to view 
(File, for example). 

Press and hold the mouse button to display the menu and 
highlight its title. 

Release the mouse button to make the menu disappear. 

If a command is not available, it is gray (dimmed) and cannot be 
chosen from the menu. 
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To Select a Menu 
Item 

• Position the pointer on the title of the menu you want to 
choose a command from. 

Press and hold the mouse button while you drag the mouse 
down the menu to highlight the menu commands. 

• Release the mouse button when the command you want to 
choose is highlighted. 

When you choose a menu command, the menu title remains 
highlighted until the command you have selected is carried out. 

If a command is followed by an ellipsis ( ... ), you will have further 
choices to make after selecting the command. 

Dimmed Command -----~I-Io~~-r 

To Open an Icon 
With the Open 
Command 

I 
1 rash 

To try selecting a menu item: 

1. Drag on the Edit menu until you highlight Show Clipboard. 

2. Release the mouse button. (Leave the Clipboard on the 
screen for now-don't try to close it.) 

• Select an icon by clicking on it. 

• Position the pointer on the File menu. 

Press the mouse button and drag to the Open command. 
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Keyboard equivalents (keystrokes you can use instead of pulling 
down the menu) are indicated by a • or + and a letter next to the 
menu commands. You can see examples of both of these on 
the File menu. 

• represents the OPEN APPLE or SOLID APPLE key. To use 
the keyboard equivalent instead of choosing from the menu, you 
press and hold one of the Apple keys and then press the 
indicated letter. 

+ represents the CONTROL key. To use the keyboard 
equivalent instead of choosing from the menu, you press and 
hold the CONTROL key and then press the indicated letter 

This section explains how to use the menu bar with a mouse. For 
more information on each of the Catalyst menus and specific 
menu commands, see Chapter 6, "Catalyst Reference." 

MenuBar----------------+-J:illlml~·~Ed~it~M~i5c~e~lIa~ne~Ou~5::::::::::::::::::::::1 
I~Open 

f[ Get Info II ~T~RL1]YS~T ~~~~~ 
"T Run Progwl", IR 8~ used 916 free 10 

Ell ipsis ------------------i--II-I...;..-F ..... 7,' ....... ...;.. ....... ...;.. ........ = .... ... ;;;:;J ........•..•................. ~=-,---.:....:..:...:.:....:..:+4 

Keyboard Equivalent ... Cl~=.~ ............... __ . ..!~ <~ \..~ 
Eject IE Sl ste~ Utili ties Quick COIl 

Menu ................. __ ... __ .- i.l'~ 

Quit 10 1.;" , • ....... ____ -~. ·7~ ,,,,m, '6 
Filer Bock\'1 II Cotoloist SysteM ~ 

<.;JI I~> Q] 

ToV iewa Menu · Pos~ion the pointer on the title of the menu you want to view 
(File, for example). 

· Press and hold the mouse button to display the menu a nd 
highlight its title. 

· Release the mouse button to make the menu disappea r. 

If a command is not available, it is gray (dimmed) and cannot be 
chosen from the menu. 
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To Select Buttons 

USing 
Windows 
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Position the pointer on the button you want to select. 

Click the mouse button. 

The button will be highlighted and the action performed. 

To try selecting a button: 

1, Click on the Cancel button in the About Catalyst. .. dialog 
box. 

Windows in Catalyst display information. That information may be 
a list of programs on a disk, or details about disk size, type, and 
volume name. 

When you open a disk icon you see its window. That window 
displays the contents of the disk. The window has a title bar, a 
close box, and an information line at the top that tells how 
many programs are on the disk and what the disk space 
utilization is. 

Other kinds of windows may also have 

• A size box that allows you to expand and contract the 
window size 
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• A scroll bar that lets you move through the window 
contents 
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To Make a Window 
Active 

I 
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• Position the pointer anywhere in the window and click. 

If there is only one window on the desktop, it is active. If more 
than one window is on the desktop, the one in the front is active 
and the others are inactive. Many windows can be open on the 
desktop at once, but only one is active. 

When you activate a window, it comes to the front, and ~s title bar 
reappears. If you click on a program icon when you are activating 
a window, that icon is selected. Otherwise the window's disk 
icon is selected. 

Inactive windows do not show tITle bar stripes, scroll controls, a 
size box or a close box. You must activate a window before you 
can use the scroll bar or close the window. 

To try activating a window: 

1. Click on the Clipboard window. 

You see the stripes in the t~le bar reappear. The Catalyst 
window is now inactive. 

31 Chapter 2: Moving Around in Catalyst With a Mouse 



To Drag a Window 

To Close An Active 
Window 

Position the pointer on the title barat the top of the window. 

Press the mouse button and drag the window. 

The window outline moves as you drag. 

Release the mouse button when you have relocated the 
window where you want ~ . 

You cannot move the window past the left edge of the screen or 
above the menu bar. 

You can cover icons and other windows w~h a window. 
Whatever was active (selected) remains so. 

To try dragging a window: 

1. Position the pointer on the Clipboard title bar. 

2. Drag the window anywhere on the screen. 

Position the pointer on the window's close box and click. 

or 

• Choose Close from the File menu. 

or 

Press CONTROL-C. 

You see the window zoom back to its icon if it is a disk window or 
disappear if it is a desktop accessory window. 

When you choose the Close command, the active window is 
closed, and any other windows on the desktop remain open. 

To try closing a window: 

1. Position the pointer on the Clipboard window's close box and 
click. 
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To Change Window 
Size 

To Use Scroll Bars to 
See More 

Posijion the pointer on the size box at the bottom right of the 
window. 

Press the mouse button and drag the mouse to change the 
window size. 

The outline you see as you drag the mouse indicates the 
potential window size and shape. 

You can drag horizontally, vertically, or diagonally. 

Release the mouse button when you have resized the 
window to your satisfaction. 

To try changing window size: 

1. Position the pointer on the Catalyst window size box. 

2. Drag diagonally up and to the left to shrink the window as 
much as possible. 

I File Edit Miscellaneous 
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Posijion the pointer on the scroll bar arrow that points in the 
direction of what you want to see. 

To scroll the window a mtle at a time, click on an arrow. 

To scroll quickly, hold the mouse button down on the arrow. 

33 Chapter 2: Moving Around in Catalyst With a Mouse 



The scroll box lets you view different areas of a window. When 
the scroll box is at the top of the vertical scroll bar, you are 
looking at the top of the window's contents. When it is at the 
bottom of a scroll bar, you are looking at the bottom of a window's 
contents. The horizontal scroll box works the same way, but 
moves to the right and left edges of the window's contents. 

Position the pointer in the scroll box, then drag the scroll box 
to move quickly through the window. 

Position the pointer in the gray area on either side of the 
scroll box (called the scroll bar) and click to scroll one 
windowful at a time. 

When windows can't be scrolled, the scroll box is not visible. 

To try scrolling: 

1. Position the pointer in the vertical scroll box in the Catalyst 
window. Drag the scroll box down. 

2. Position the pointer in the horizontal scroll box in the Catalyst 
window. Drag the scroll box to the right. 
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Moving Around in Catalyst 
Without a Mouse 
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Introduction This chapter explains how to move around in 
Catalyst without a mouse, use the menu bar and 
dialog boxes, and work with windows. 

The first part of the chapter is a step by step tutorial. 
It describes four terms you need to be familiar with 
and guides you in learning how to use keystrokes 
and keyboard equivalents for mouse pointing, 
selecting, and dragging operations. 

The remainder of the chapter provides background 
on using menus and windows, and summarizes how 
to use them without a mouse. 

It's not as easy to use Catalyst without a mouse (we 
recommend you get one), but it can be done. 

When you are comfortable with moving around in 
Catalyst without a mouse, go on to Chapter 4, 
"Putting Catalyst to Work." 
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Moving 
Without a 
Mouse: 
Tutorial 

Moving the Pointer 

You can start up programs, move icons, choose from menus, 
work with windows, and accomplish other Catalyst tasks without a 
mouse. 

You use OPEN APPLE, SOLID APPLE, and arrow key 
keystroke combinations to perform mouselike operations that 
are described by these terms: 

• Select means to posHion the pointer on an item and 
highlight it. 

• Click means to press and release the SOLID APPLE key 
once. 

• Double-click means to position the pointer on an item, and 
press and release the SOLID APPLE key twice in quick 
succession to select and open the Hem. 

• Drag means to posHion the pointer on an item and move the 
item to a new place. 

Once you learn to manipulate the keys in these four ways, you 
have all the tools you need. 

The pointer marks your place on the screen. You move the 
pointer by using the OPEN APPLE, SOLID APPLE, and arrow 
keys. You end pointer movement by releasing the OPEN 
APPLE key. 

The pointer's shape depends on what you are doing. Usually H 
is shaped like an arrow. The pointer becomes a watch when 
Catalyst is doing something that takes a IHtie time, and an 1-
beam when it is positioned in an edHing area. 

To try moving the pointer: 

1. Press and hold the OPEN APPLE key down. 

2. Press and release the SOLID APPLE key. 

3. Continue holding the OPEN APPLE key down while you use 
the arrow keys to move the pointer around the screen. 

4. Release the OPEN APPLE key to end the pointer 
movement. 
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Selecting by Clicking Selecting means to position the pointer on an item and highlight 
it. Selecting an icon or window indicates where you want the 
next action to take place, and changes the selected item. 

• Selecting a disk or program icon makes it dark. 

• Selecting a window activates it and brings it to the front. 

• Selecting a close box closes its window. 

• Selecting a program icon in a RAM disk window makes it 
white . 

Note: You cannot edit the name of an icon simply by selecting it 
as you can on the Macintosh desktop. See Chapter 6, "Catalyst 
Reference," for renaming instructions. 

To try selecting by clicking: 

1. Position the pointer on the trash icon: 

Press and hold the OPEN APPLE key down. 

Press and release the SOLID APPLE key. 

Continue holding the OPEN APPLE key down while you use 
the arrow keys to move the pointer (don't release the OPEN 
APPLE key yet). 

2. Press and release the SOLID APPLE key once to select the 
trash. 

3. Move the pointerfrom the trash icon to the Catalyst disk icon 
and click (press and release) the SOLI D APPLE key once to 
select the Catalyst disk icon. 

4. Release the OPEN APPLE key to end the pOinter 
movement. 

Notice that when you select the trash icon, it becomes dark 
(highlighted). When you move the pointer to the Catalyst icon 
and click again, the trash icon becomes white (deselected) and 
the Catalyst icon becomes dark (selected). 
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Dragging Dragging means to position the pointer on an item, select it, and 
move (drag) it to a new place. 

• When you drag a program icon from one window to another, 
Catalyst makes a copy of the program. 

• When you drag a program icon onto the trash, the program is 
removed from the disk ~ was stored on. 

• When you drag a disk icon, it moves. (You can't copy a disk 
by dragging ~s icon as you can on a Macintosh. Use Quick 
Copy instead.) 

• When you drag a Disk II or UniDisk 3.5 icon onto the trash, 
Catalyst removes the disk contents from memory. A UniDisk 
3.5 disk is also ejected if you drag its icon onto the trash. 

• When you drag on a menu, you move the pointer through 
the commands. 

To try dragging: 

1. Position the pointer on the Catalyst icon: 

Press and hold the OPEN APPLE key down. 

Press and release the SOLID APPLE key. 

Continue holding the OPEN APPLE key down while you use 
the arrow keys to move the pointer (don't release the OPEN 
APPLE key yet). 

2. Press and hold down the SOLID APPLE key (and continue 
holding down the OPEN APPLE key) while you press the 
LEFT ARROW key. 

Watch an outline of the icon move across the screen as you 
press the arrow key. 

3. Release the SOLID APPLE key. 

Watch the icon image move to the new pos~ion and fill the 
outline. 

4. Press and hold down the SOLID APPLE key again while you 
press the RIGHT ARROW key and drag the icon outline back 
to the upper right corner of the screen. 

40 Chapter 3: Moving Around in Catalyst Without a Mouse 



Opening by Double­
Clicking 

5. Release the SOLID APPLE key to reposition the icon. 

Notice that the icon image moves to the new position and fills 
the outline as soon as you release the SOLID APPLE key. 

6. Release the OPEN APPLE key to end the pointer 
movement. 

Double-clicking means to position the pointer on an item, and 
press and release the SOLID APPLE key twice in quick 
succession. 

Double-clicking selects the item and opens it. When you open a 
disk icon, you see it's contents in a window. When you open a 
program icon, the program is started up by Catalyst. 

To try opening by double-clicking: 

1. Position the pointer on the Catalyst icon: 

Press and hold the OPEN APPLE key down. 

Press and release the SOLID APPLE key. 

Continue holding the OPEN APPLE key down while you use 
the arrow keys to move the pointer (don't release the OPEN 
APPLE key yet) . 

2. Press and release the SOLID APPLE key twice to double­
click (select and open) the icon. 

3. Release the OPEN APPLE key to end the pointer 
movement. 

You'll see the contents of the Catalyst disk in a window. Each of 
the icons in the window represents a program. Double-clicking 
on one of the program icons (don't do it now) will start up the 
program. 

If a disk window is already open when you double-click its icon, 
the double-click brings the window to the front. 
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The trash icon is there for you to discard things. It should be 
used with caution. Here's how it works: 

• When you drag a program icon into the trash, Catalyst asks if 
it's OK to throwaway, and then removes the program from 
the disk on which it resides. 

• When you drag a disk icon into the trash, Catalyst removes 
the disk contents from the computer's memory. 

• When you drag a UniDisk 3.5 disk icon into the trash, Catalyst 
removes the disk contents from the computer's memory and 
ejects the disk. 

Note: there are two menu alternatives to using the trash. 
Discard Disk .. . removes a disk from the desktop. Delete 
Program ... removes a program from a disk. The next section, 
"Using the Menu Bar," explains how to select from the menu 
without a mouse. 

To try using the trash: 

1. Drag the Catalyst disk icon onto the trash icon. 

When the trash icon is darkened, release the SOLID APPLE 
key and the Catalyst icon will disappear. Putting it into the 
trash has removed the contents of the Catalyst disk from the 
computer's memory. 
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Using the 
Menu Bar 

2. If your Catalyst is on a UniDisk 3.5, reinsert the disk to put 
Catalyst back on the desktop. 

or 

If your Catalyst is on a floppy disk, press OPEN APPLE-S. 
Then press RETURN. This puts Catalyst back on the 
desktop. (You'll find out more about the Switch Disks 
command in Chapters 4 and 5). 

• File Edit Miscellaneous 

You choose a command from the Catalyst menu barto tell your 
Apple \I what you want to do. 

All the commands available to you on a menu are black. Those 
you can't use are gray (dimmed). An ellipsis ( .. . ) following a 
command indicates that you'll have further choices to make after 
selecting that command. 

Keyboard equivalents (keystrokes you can use instead of pulling 
down the menu) are indicated by a " or + and a letter next to the 
menu commands. You can see examples of both of these on 
the File menu. 

" represents the OPEN APPLE or SOLID APPLE key. To use 
the keyboard equivalent instead of choosing from the menu, you 
press and hold one of the Apple keys and then press the 
indicated letter. 
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• represents the CONTROL key. To use the keyboard 
equivalent instead of choosing from the menu, you press and 
hold the CONTROL key and then press the indicated letter. 

This section explains how to use the menu bar without a mouse. 
For more information on each of the Catalyst menus and specific 
menu commands, see Chapter6, "Catalyst Reference." 
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Press ESC to use the menu. 

Use the LEFT or RIGHT arrow keys to position the pointer on 
the title of the menu you want to view (File, for example). 

Use the UP or DOWN arrow keys to position the pointer on a 
command on a particular menu. 

Press ESC to leave the menu and return to the desktop. 

ESC switches between the desktop and the menu. If a 
command is not available, it is gray (dimmed) and cannot be 
chosen from the menu. 
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To Select a Menu 
Item 

To Open an Icon 
With the Open 
Command 

Press ESC to use the menu. 

Use the arrow keys to highlight the menu commands. 

Press RETURN when the command you want to choose is 
highlighted. 

When you choose a menu command, the menu title remains 
highlighted until the command you have selected is carried out. 

If a command is followed by an ellipsis ( ... ), you will have further 
choices to make after selecting the command. 

I 
Jmh 

• Select an icon by clicking on it. 

Press ESC. 

Use the arrow keys to posijion the pointer on the Open 
command in the File menu. 

Press RETURN. 

When you select a disk icon and choose Open, the command 
opens the disk window. 

When you select a program icon and choose Open, the 
command starts up the program. 

You can also open an icon by double-clicking on ij. 
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Using Dialog 
Boxes 

To Use Keystroke 
Shortcuts 

Whenever Catalyst needs more information from you, it presents 
a dialog box. A dialog box has buttons to click, and 
sometimes a place for you to type more information. 

A dialog box may alert you if you're about to do something that 
could cause you to lose information, and gives you a chance to 
cancel what you were about to do. 

You can use the OPEN APPLE, SOLID APPLE, and arrow keys 
to move around in dialog boxes and make choices, or you can 
use keystroke shortcuts. 

All buttons have keystroke equivalents. You can also select any 
button by positioning the pointer on IT and clicking on IT. 

Press ESC to select a Cancel button. 

• Press RETURN to select an OK button. 

Press OPEN APPLE-N to view the contents of a different 
disk in a dialog box. 

• Use the UP and DOWN arrows to move through items in a list. 

• When an item in a list is selected, press RETURN to proceed 
with Delete ... , Add ... , Discard ... , Copy .. . , or Run. 

• Press 1, 2, or 3 to activate the RAM disk status buttons. 
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Using 
Windows 

Windows in Catalyst display information. That information may be 
a list of programs on a disk, or details about disk size, type, and 
volume name. 

When you open a disk icon you see its window. That window 
displays the contents of the disk. The window has a title bar, a 
close box, and an information line at the top that tells how many 
programs are on the disk and what the disk space utilization is. 

Other kinds of windows may also have 

• A size box that allows you to expand and contract the 
window size 

• A scroll bar that lets you move through the window 
contents 
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To Make a Window 
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• Position the pointer anywhere in the window and click SaUD 
APPLE once. 

If there is only one window on the desktop, it is active. If more 
than one window is on the desktop, the one in the front is active 
and the others are inactive. Many windows can be open on the 
desktop at once, but only one is active. 
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To Drag a Window 

To Close an Active 
Window 

When you activate a window, it comes to the front, and its title bar 
reappears. If you click on a program icon when you are activating 
a window, that icon is selected. Otherwise the window's disk 
icon is selected. 

Inactive windows do not show title bar stripes, scroll controls, a 
size box or a close box. You must activate a window before you 
can use the scroll bar or close the window. 

Position the pointer on the title bar at the top of the window. 

Press and hold SOLI D APPLE while you press the arrow 
keys to drag the window. 

The window outline moves as you drag. 

Release SOLID APPLE when you have relocated the 
window where you want it. 

You cannot move the window past the left edge of the screen or 
above the menu bar. 

You can cover icons and other windows with a window. 
Whatever was active (selected) remains so. 

Position the pointer on the window's close box and click 
SOLID APPLE. 

or 

Choose Close from the File menu. 

or 

Press CONTROL-C. 

You see the window zoom back to its icon if it is a disk window or 
disappear if it is a desktop accessory window. 

When you choose the Close command, the active window is 
closed, and any other windows on the desktop remain open. 
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To Change Window 
Size 

To Use Scroll Bars to 
See More 

Position the pointer on the size box at the bottom right of the 
window. 

Press and hold SOLID APPLE while you press the arrow keys 
to change the window size. 

To widen the window, use RIGHT ARROW. 

To make the window more narrow, use LEFT ARROW. 

To lengthen the window, use DOWN ARROW. 

To shorten the window, use UP ARROW. 

The outline you see as you drag the window indicates the 
potential window size and shape. 

Release SOLID APPLE when you have resized the window 
to your satisfaction. 
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Position the pointer on the scroll bar arrow that points in the 
direction of what you want to see. 

To scroll the window a little at a time, click on an arrow. 

To scroll quickly, hold the SOLID APPLE key down. 
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The scroll box lets you view different areas of a window. When 
the scroll box is at the top of the vertical scroll bar, you are 
looking at the top of the window's contents. When it is at the 
bottom of a scroll bar, you are looking at the bottom of a window's 
contents. The horizontal scroll box works the same way, but 
moves to the right and left edges of the window's contents. 

Position the pointer in the scroll box, then drag the scroll box 
to move quickly through the window. 

Position the pointer in the gray area on either side of the 
scroll box (called the scroll bar) and press and release SOLI D 
APPLE to scroll one windowful at a time. 

When windows can't be scrolled, the scroll box is not visible. 
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Chapter 4: 

Putting Catalyst to Work 
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Introduction Catalyst gives you instant access to all your 
programs, and to the programs that come with 
Catalyst: System Utilities, Filer, Quick Copy, 
MousePaint, BASIC, and Backup II. 

This chapter explains how to 

D Make sure you have matching serial numbers on 
your Catalyst Master and Backup disks 

D Install (copy) the programs you frequently use 
onto a high-capacity disk 

D Run programs with Catalyst 

D Select a startup program on a particular disk 

D Use Catalyst for program management 

D Quit Catalyst 

You should be familiar with moving around in 
Catalyst with a mouse (Chapter 2) or without one 
(Chapter 3) before you begin this chapter. 
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Checking Your 
Catalyst Serial 
Numbers 

1 . Start up Catalyst 
with the Master 
disk 

2. Choose the 
command About 
Catalyst. .. from 
the Apple menu 

It's important to make sure that the serial number on your Catalyst 
Master and Catalyst Backup disk labels matches the serial 
number on the disks themselves. The correct disk serial number 
is listed in the About Catalyst. .. window. Follow the numbered 
instructions to check that your disk labels and serial numbers 
agree. 

If you find a discrepancy, you can return your Catalyst disk(s) to 
Quark for free reserialization. See Appendix C, "Catalyst Service 
and Revised Product Versions," for instructions. 

If you haven't started up Catalyst, see the instructions in the 
"Starting Up" section of Chapter 1. 

With a mouse: 

• Move the pointer to the Apple menu. 

• Drag on the menu to highlight About Catalyst. .. 

• Release the mouse button. 

Without a mouse: 

• Press ESC. 

• Use the arrow keys to move the pointer to About Catalyst. .. 
on the Apple menu. 

• Press RETURN to accept the choice. 
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3. Compare the serial 
number in the 
About Catalyst ... 
window with the 
serial number on 
the label of the 
Master disk 

4. Close the About 
Catalyst ... window 

5. Choose the Quit 
command from the 
File menu 

6. Restart your 
computer using 
the Catalyst 
Backup disk 

7. Choose the 
command About 
Catalyst. .. from 
the Apple menu 

To look at the label on a floppy disk, open the drive door and pull 
the disk out. (Do not reinsert the disk). 

To look at a label on a 3.5-inch disk, press the eject button on the 
drive. (Do not reinsert the disk.) 

Quark™ 
Catalyst (uersion 3.0) 

Serial ~8 
I: Cancel :I 

@Copyright 1982-85 O.uark Incorporated 

Click on the Cancel button if you have a mouse, or press ESC if 
you don't have a mouse. 

After you have chosen Quit you see a message: 

Press OPEN APPLE CONTROL RESET to reboot 

Insert the Catalyst Backup disk in the drive. 

Press and hold the OPEN APPLE and CONTROL keys while 
you press and release the RESET key. Then release the OPEN 
APPLE and CONTROL keys. 
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8. Compare the serial 
number in the 
About Catalyst. .. 
window with the 
serial number on 
the label of the 
Backup disk 

9. Close the About 
Catalyst. .. window 

10. Make sure your 
Master and 
Backup disks have 
the same serial 
number. 

Installing 
Programs With 
Catalyst 

To look at the label on a floppy disk, open the drive door and pull 
the disk out. 

To look at a label on a 3.5-inch disk, press the eject button on 
the drive. 

Click on the Cancel button if you have a mouse, or press ESC if 
you don't. 

If any of your serial numbers don't match, see Appendix C for 
instructions. 

Catalyst lets you copy, or install, the programs you frequently 
use onto a high-capacity disk. You can install programs on a 
UniDisk 3.5 or a hard disk-a QC1 0, QC20, ProFile, or any other 
high-capacity ProDOS disk drive that connects to your Apple. 

A new disk (3.5-inch or hard disk volume) must be formatted 
(initialized) before you install programs on it. If you need to 
format a new disk, use System Utilities. Remember that each 
disk (volume) should have a unique name. Do not name your 
disks "CATALYST," since that is the name of the Catalyst Master 
and Backup disks. 

Catalyst must be aware of both your source and destination 
disks (volumes) to perform program installation. The source disk 
is the disk you want to copy a program from; the destination disk 
is the disk you will copy the program to. You must identify the 
volumes to Catalyst, and their disk icons must be on the 
desktop. If your source and destination volume icons are not on 
the desktop, you use Switch Disks or eject one 3.5-inch disk and 
insert another. 
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Installing Programs 
With a Mouse 

There are two methods of installing a program with Catalyst. If 
you have a mouse, you drag the program's icon from the source 
disk's window to the destination disk's window. If you don't have 
a mouse, you use the Copy Program .. . command on the 
Miscellaneous menu. Catalyst copies the program files to the 
destination volume at installation, adjusting the program's file 
structure to go on the large volume. 

If you need to swap (change) disks during installation, Catalyst 
prompts you. After swapping floppy disks, you must inform 
Catalyst of the swap by clicking on OK or pressing RETURN in 
response to the request. 

If Catalyst doesn't have sufficient information to move and install 
a program, a dialog box tells you that it is a custom program. 
Appendix B, "Adding Custom Programs," explains what to do. 

Make sure that: 

• The source and destination disk icons are open (their 
windows are visible) . 

• The icon for the program you want to install is visible in the 
source disk window. 

If the program icon isn't visible, reposition the window or use 
the size box or scroll controls to make it visible. 

If you need more specific instructions for moving and sizing 
windows, see Chapter 2. 
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Installing Programs 
Without a Mouse 

• Your destination disk is formatted. 

If you need to format a disk, use System Utilities. Give each 
of your disks a unique name, and don't name any of them 
"CATALYST," since that is the name of your Catalyst disk. 

Now drag the program icon into the destination disk window. 
You see the program icon appear in the destination disk window 
when Catalyst has copied it. 

Make sure that the source and destination disk icons are on the 
desktop and that your destination disk is formatted. 

If you need to format a disk, use System Utilities. Give each of 
your disks a unique name, and don't name any of them 
"CATALYST," since that is the name of your Catalyst disk. 

Now, to install the program: 

1. Choose Copy Program ... from the Miscellaneous menu. 

Press ESC and use the arrow keys to move through the 
menus until the command is highlighted. 

Press RETURN to choose Copy Program ... 

2. Select the program you want to copy using the arrow keys. 

Press OPEN APPLE-N to view the programs on other disks 
or volumes until you see the one you want to copy. If a disk 
icon wasn't on the desktop when you started, you won't be 
able to see a list of programs ~ contains. 
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3. Press RETURN to select the highlighted program. 

4. Select the volume (disk) you want to copy to using the arrow 
keys. 

If a disk icon wasn't on the desktop when you started, it won't 
be listed as one of the volumes you can copy to . 
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5. Press RETURN to select the highlighted volume. 

If you get a message that the program you are copying is a 
custom program, see Appendix B, "Adding Custom 
Programs," for more information. 
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Copying the Catalyst 
System Program 

Copy Protection 

Usi ng Catalyst 

The Catalyst System program must be on one of the disks you 
are using at all times for Catalyst to work. By installing Catalyst 
System on your program disks along with your other programs, 
you ensure that Catalyst will work no matter which disks you have 
in which drives. If you have a hard disk drive, you only need to 
install Catalyst System on tt, and not on other disks. 

Catalyst locks copy-protected programs to itself, using the 
Catalyst serial number. These programs can be reinstalled by 
the same Catalyst program, but cannot be copied or installed by 
another Catalyst system. Programs that aren't copy-protected 
can be installed on as many systems as you want. 

Rpp leW 

Miscellaneous 

CATAl YST 

This is a copy protected proqr aM. Once 
you have installed it, it will be 
perManently locked to your Catalyst. 

OK to continue with installation? 

I 
lrolh 

The Catalyst disks are copy-protected. They should be shielded 
from excess wear when possible: use them to start up with, but 
avoid installing programs on your Catalyst Master and Backup 
disks. 

The Catalyst Master disk comes with some programs already 
installed on it: System Utilities, Filer, Quick Copy, MousePaint, 
BASIC, and Backup II. Chapter 6, "Catalyst Reference," has 
reference information about these programs. 
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Changing Disks 

If your Catalyst Master is on a floppy disk, you'll find most of these 
programs on two separate floppy disks. Quick Copy, 
MousePaint and Backup II are on Catalyst Programs 1; System 
Utilities is on Catalyst Programs 2. (BASIC and Filer are on 
Catalyst Master.) 

If you are using a hard disk, copy (install) all these programs on it. 

Use System Utilities to prepare, or initialize, blank disks to 
receive information. See Appendix A, "Using System Utilities 
With Your UniDisk 3.5," for more information on the program. 

Use Filer to rename your disks. Filer is similar to System Utilities. 
Filer has most of the same capabilities but a different way of 
prompting you for information. 

Use Quick Copy to make copies of disks faster than with 
System Utilities or the Filer. It is especially useful for copying 
UniDisk3.5 disks. 

Use MousePaint to draw pictures and have fun with your 
mouse. 

Use BASIC if you are interested in programming. 

Use Backup II to back up your hard disk files. 

When you want to use a program that's not on one of the disks in 
one of your drives, you may have to remove one disk and insert 
another. Here's how. 

To change a 3.5-inch disk: 

• Select the disk icon. 

• Choose Eject from the File menu, or use OPEN APPLE-E. 

Remove one 3.5-inch disk and insert another. 

Catalyst displays the new 3.5-inch disk icon on the desktop 
whenever you change 3.5-inch disks. 
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Running a Program 
With a Mouse 

Running a Program 
Without a Mouse 

To change a floppy disk: 

• Choose Switch Disks from the Miscellaneous menu, or use 
OPEN APPLE-S. 

Remove one floppy disk and insert another. 

Press RETURN orclick on the OK button to indicate you 
have changed disks. 

Catalyst checks all your Disk II drives. New floppy disk icon(s) 
appearon the desktop after you press RETURN. 

You can run (open) any program on the Catalyst desktop. When 
you select a program to run, Catalyst puts the program in memory 
and returns you to the Catalyst desktop when you quit the 
program. 

• Open the disk icon containing the program you want to run. 

• Select the program icon: 

Double-click on the program icon to select and run it. 

or 

Click on the program icon and choose the Open command 
from the File menu. 

The Catalyst desktop clears and the program you selected 
starts up. 

You can run (open) any program on the Catalyst desktop. When 
you select a program to run, Catalyst puts the program in memory 
and returns you to the Catalyst desktop when you quit the 
program. 

• Choose Run Program ... from the File menu. 

Press ESC and use the arrow keys to move through the 
menus until the command is highlighted. 

Press RETURN to choose Run Program ... 
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Returning to Catalyst 

• Select the program you want to run using the arrow keys. 

Press OPEN APPLE-N to show the programs on each disk 
until you see the one you want to run . If a disk icon wasn't on 
the desktop when you selected the Run Program ... 
command, you won't be able to see a list of programs it 
contains. 

IJ 

Run a Progr aM 
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Progr aMS on CATALYST 
BASIC 
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I Mouse~ amt 
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i 
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• Press RETURN to select the highlighted program. 

The Catalyst desktop clears and the program you selected 
starts up. 

• Choose the Qu~ or Exit option from the program's main 
menu. 

You return to the Catalyst desktop when you quit the program. 

The method for quitting each program varies w~h the program. 
However, most programs have a Quit option in their main menu. 

When you qu~ BASIC programs, you may see a] prompt and 
blinking cursor rather than the Catalyst desktop. Type BYE and 
press RETURN"to get to Catalyst. 
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Setting and Clearing 
Startup Programs 
With a Mouse 

Setting and Clearing 
Startup Programs 
Without a Mouse 

Use the Set Startup command to choose a startup program on a 
particular disk. The program you select runs automatically when 
you start up Catalyst with the disk installed (in a drive). 

If you are using two disks, each of which has a startup program 
set, Catalyst chooses the first startup program it finds. 

• Open the icon of the disk you want to use for starting up. 

• Select the program you want to run when you start up 
Catalyst. 

Click on a program icon to select it. 

• Choose Set Startup from the Miscellaneous menu. 

A dialog box requests confirmation. 

• Click on OK to confirm. 

OK to ~lake "BRSIC" the Startup proqr al~ 
for the disk "CRTRLYST"? 

b) 
CAl Al1S1 

To clear the startup program on a particular disk, select the 
disk icon. Since no program icon is selected, the command 
changes to Clear Startup. When you choose Clear Startup, a 
dialog box requests confirmation. 

Use the Set Startup command to choose a startup program on a 
particular disk. The program you select runs automatically when 
you start up Catalyst with the disk installed (in a drive). 

64 Chapter 4: Putting Catalyst to Work 



Quitting Catalyst 

If you are using two disks, each of which has a startup program 
set, Catalyst chooses the first startup program it finds. 

Use the OPEN APPLE, SOLID APPLE, and arrow keys to 
move the pointerto the program you want to run when you 
start up Catalyst. 

Press the SOLI D APPLE key to select the program icon. 

• Choose Set Startup from the Miscellaneous menu. 

A dialog box requests confirmation. 

Press ESC to Cancel, or RETURN to OK your selection. 

To clear the startup program on a particular disk, select the 
disk icon. Since no program icon is selected, the command 
changes to Clear Startup. When you choose Clear Startup, a 
dialog box requests confirmation. 

916 I'm 

~? Clear the Startup proqml on the disk 
Ii.U "CATRL YST"? 

• Choose Quit from the File menu. 
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Making 
Backup Copies 
of Program 
Disks 

Quick Copy is a program on the Catalyst disk that you can use to 
make a duplicate, or backup copy, of any ProDOS disk. 

With a mouse: 

Double-click on the Quick Copy icon to open it. 

• Drag on the File menu to choose Copy Volume ... 

• Select the volume you want to copy by: 

Using the UP and DOWN arrows to highlight the volume 

or 

Clicking on the volume to highlight it. 

• IJI.[JI Edit 

Copy a UoluMe 

Slot Dri~e Uolu~le naMe: 
5 1 CATAL YST {f 

• Click on the Copy button or press RETURN to choose 
Copy ... 

• Select the slot and drive (where your destination disk is) to 
copy to. 

Use the UP and DOWN arrows or click on the slot and drive 
number to highlight them. 
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COpy a UoluMe 

Copy ~o luille in slot 6, dri~e 1 to: 

eel 

• Click on OK or press RETURN to copy your disk. 

• Choose Quit from the File menu to return to Catalyst when 
the copy is complete. 

Without a mouse: 

• Choose Run Program ... from the File menu. 

Use the UP and DOWN arrows to select (highlight) Quick 
Copy. 

Press RETURN to run the program. 

• Choose Copy Volume ... from the Quick Copy File menu. 

• Select the volume you want to copy by using the UP and 
DOWN arrows to highlight the volume. 

Press RETURN to choose Copy ... 

• Select the slot and drive to copy to by using the UP and 
DOWN arrows. 

Press RETURN to copy your disk. 

• Choose Quit from the File menu to return to Catalyst when 
the copy is complete. 
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Other Program 
Control 

Getting Information 
About a Program 

For further information on these commands and working with 
disks, see Chapter5, "Disk and Memory Reference." 

The Program Info window for a program identifies program 
volume and title , has space for comments, and includes control 
settings (buttons) for RAM disk use. The Program Info window 
for custom programs has additional information. See "Using Get 
Info" in Chapter5. 

With a mouse: 

Select the program icon you want information about. 

Choose Get Info from the File menu. 

Click on the close box to close the Program Info window. 

Without a mouse: 

Use the OPEN APPLE, SOLI D APPLE, and arrow keys to 
move the pointer to the program icon you want information 
on. 

Press SOLID APPLE to select the icon. 

Press OPEN APPLE-lor choose Get Info from the File menu. 

Press CONTROL-C to close the Program Info window. 

Progr aN Info 
1 prOjr PrograM uolu llle: CRTRl YST 

COll1l11ent: 
HousePaint (uersion 1,1) 
Copyright 1985 Rpple COMPuter 

Hljtl] r~ .lti,:: :;:Rt1 dis!·: [,I[bing: 
o ll'1I1'1; [r'pI! 0 C'lP 'l ,II:. :'i't.wt up 0 Cr'P!,1 (Ill fi·cst. lj:,,~ 
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Removing a Program 
From a Disk 

Rearranging 
Program Icons 

With a mouse: 

Drag the program into the trash. 

A dialog box requests confirmation. 

• Click on OK to verify the program removal. 

Without a mouse: 

• Choose Delete Program ... from the Miscellaneous menu. 

Use the keystroke shortcuts to make a selection: 

Use the UP and DOWN arrows to move through items in a list. 

Press OPEN APPLE-N to view the contents of a dffferent 
disk. 

• Press RETURN to delete the program you have selected. 

A dialog box requests confirmation. 

Press RETURN to verify the program removal. 

With a mouse: 

Drag the program icon to another place in the disk window. 

Without a mouse: 

There is generally no reason to rearrange program icons without 
a mouse, since you can use menu commands to copy and delete 
and so on. However, here is how to move the icons ff you want 
to play: 

• Use the OPEN APPLE, SOLID APPLE, and arrow keys to 
move the pointer to the program icon you want to move. 

• Press and hold SOLID APPLE (selects the icon) while you 
press arrow keys to move the icon. 

As long as you continue to hold SOLID APPLE you can move 
the icon. 
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Release SOLID APPLE when you have moved the icon to 
the neW location. 
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Introduction This chapter discusses the four types of disk, or 
volume, storage that you can use with Catalyst and 
your Apple II: 

D 3.5 high-capacity storage (UniDisk 3.5) 

D 5-1/4 inch floppy disk storage (Disk II) 

D Hard disk storage (such as Quark QC1 0, Quark 
QC20, Apple ProFile) 

D High-speed cache memory on a RAM disk (Apple 
II Memory Expansion Card and Apple 256K 
Memory Expansion Kit) 

The first part of the chapter summarizes disk 
management with Catalyst. The remainder of the 
chapter details reference information about each 
type of disk storage as it is used with Catalyst. 
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Managing 
Disks 

DC ! 

I ProF ile .1 

The Catalyst Desktop 
File 

The Catalyst System 
Program 

You use the commands on the Miscellaneous and File menus to 
do your desktop disk management. In addition, the Quick Copy 
program lets you copy disks, and the System Utilities program 
gives you the full range of operating system (ProDOS) utilities to 
use with all the programs you install with Catalyst. 

Disks are represented by icons. Catalyst uses six types of 
disk icons: 

• Disk II, Apple's 5-114 inch floppy disk storage 

• UniDisk 3.5, Apple's high-capacity storage (800K per disk) 

• QC, Quark's hard disk series with 10 or 20 megabytes of 
storage 

• ProFile, Apple's hard disk w~h 5 or 1 0 megabytes of storage 

RAM disk, a high-speed cache memory "disk" on a plug-in 
card (the Apple lie Memory Expansion Card) 

• Generic, for all other disks 

Catalyst displays the contents of a disk in a window. 

Catalyst uses a desktop file on each volume to store information 
about the programs installed on that volume. Catalyst stores and 
updates information on windows, programs, the startup program, 
pathnames, and so on, in the desktop file. 

For information about path names, see "Techniques for Disk File 
Management" in Appendix A. 

The Catalyst System program must be on at least one of the 
disks you have mounted (in a disk drive) at all times for Catalyst to 
work. Each time you quit a program you have run from Catalyst, 
the Catalyst System program must be reloaded into your 
computer's memory. It is best to keep the Catalyst System 
where it runs fastest (in descending order: RAM disk, hard disk, 
3.5-inch disk). 
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Formatting Disks 

Copying Programs 

Creating Startup 
Programs on Disks 

All disks must be formatted. Formatting, sometimes called 
initializing, prepares disks to receive information. Before you use 
Catalyst to install or copy your programs onto disks or volumes 
the first time, you must format them. Use the Format a Disk 
option in the System Utilities program. 

Do not format the Catalyst Master or Backup disks, or any other 
disk that contains information (unless you no longer need the 
information). Formatting removes anything that's on a disk. 

To copy a program, you drag its icon from one disk window to 
another if you have a mouse, or select Copy Program ... from the 
Miscellaneous menu if you don't have a mouse. 

When you copy a program to a disk (the destination volume) that 
already contains a version of that program, Catalyst first removes 
the program from the destination volume, then copies from the 
source to the destination volume. Catalyst asks you to confirm 
whether you want to replace an old version of a program with a 
newerone. 

When you first start up Catalyst, Clear Startup appears on the 
Miscellaneous menu. You must select a program icon forthe 
command to change to Set Startup on the menu. 

You can create a startup program on any disk. Select (highlight) 
the program you want to start up automatically. Choose Set 
Startup from the Miscellaneous menu. You are asked for 
confirmation. 

Each time you start up your computer, Catalyst searches for a 
startup program. Catalyst looks first in the drive you have started 
up (booted) from; then it searches through the disks connected 
to your Apple in descending numerical order, beginning with the 
highest numbered slot (port). 

To clear the startup program on a particular disk, make sure its 
disk icon (ratherthan a program icon) is selected. When no 
program icon is selected, the Set Startup command changes to 
Clear Startup. When you choose the Clear Startup command, a 
dialog box asks for confirmation. 
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Using Get Info The Get Info command on the File menu provides information 
about the selected icon. Use either the menu command or 
OPEN APPLE-I to get information about a selected icon. 

Disk Info windows identify a disk's title (Volume name), location 
(Volume mounted in ... ), disk type, the name of the startup 
program (if any), and the amount of storage on the disk. 

~Edit 

, m Disk Info ra1 UoluMe naf,re: eATAl YST bJ IO I UolUMe Mounted in slot 7, driue 1 ~ 
10 L 
10 G Disk type: Disk 3.5 

SRS Startup proqraf~: * None * 
'''., .. ........... ~ ... ... ....... ....... , ...... , ............................. ............. " ............................... " ............ " .. 

Total storage: 1600 blocks 
r-- Used: 684 blocks 
~ Free: 916 blocks 

I 
lmh 

There are two types of Program Info windows: those for 
commercial programs and those for custom programs. 

The Program Info window for commercial programs includes 
program volume, title, an editable prefix path, and comments 
written by the developer. (Unless the program's manual 
discusses how to change the prefix setting, it's not advisable to 
do so.) The Program Info window also includes three control 
settings (buttons) for RAM disk use. The Automatic RAM disk 
caching status buttons let you load a program onto a memory 
expansion card, either at startup or the first time you use the 
program. See "RAM Disk Control Settings" later in this chapter 
for more information. 
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The Program Info window for custom programs lets you identify 
program volume, title, system file name, prefix, and program 
patla: When you install a custom BASIC, Logo, or other ProDOS­
compatible program, you fill in (and can edit) the information that 
appears in the program's information window. For more 
information on Program Info windows for custom programs, see 
Appendix B, "Adding Custom Programs." 

, Edit Miscellaneous 

CRTRL YST 1111) 11 
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To close a Get Info window, click on the close box or press 
CONTROL-C. 
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Saving Information 
on Disks 

Copying Disks 

Renaming Disks 

Catalyst automatically saves any changes you make on the 
desktop when you run a program, set startup, quit, add, or 
delete a program, or select the Eject command. 

When you save documents created with a program, you save 
them using whatever process the program provides. You don't 
see icons for program-specific docu ments or data files as you do 
on the Macintosh desktop. 

You can copy disks using any of four utilities: 

• The Catalyst Quick Copy program 

Copy a Volume in the Filer program 

Duplicate a Disk in the System Utilities program 

A copy utility provided by a program 

It is fastest to copy 3.5-inch disks with Quick Copy, particularly on 
a one-drive system. 

There are three ways you can name a disk: 

• When you format a disk, you are prompted for a name. 

• When you make a copy of a disk using Quick Copy, Copy a 
Volume, or Duplicate a Disk, you can give the new copy a 
new name. 

• When you use the Filer program you can rename disks 
(Rename a Volume) and files (Rename Files) directly. 

To rename a disk with the Filer, choose Volume Commands. 
Then choose Rename a Volume. Type the slot (port) , drive, 
and new volume (disk) name as you are prompted. 
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UniDisk 3.5 

Copying and Backing 
Up 3.S-inch Disks 

**************************************** 
* * * RE NAME A VOLUME * 
* * 
************~ * *************************. 

--RENA ME- -
THE VOL UME IN SLOT ( 6 ) 

DR IVE 

NE\v VO LUME NAME 

- - PRESS <R ET) TO ACC EPT <ESC > TO EXIT - -

A disk name can be a maximum of 15 characters. The name must 
start with a letter, and tt can contain only letters, numbers, and 
periods. For information about names in subdirectories, see 
Appendix A, "Using System Utilities With Your UniDisk 3.5." 

UniDisk 3.5 is a high-capacity storage system that uses 3.5-inch 
disks. Each double-sided disk provides 800 kilobytes of 
storage, orthe equivalent of what you can store on six floppy 
disks. 

A note on flashing lights: When you use the UniDisk 3.5 
with Catalyst, the drive light flashes frequently. Don't worry: the 
light is flashing because Catalyst is checking to see whether you 
have swapped 3.5-inch disks recently. 

Chapter 4, "Putting Catalyst to Work," explains how to install 
programs on a 3.5-inch disk. 

The Catalyst Quick Copy program lets you copy 3.5-inch disks 
faster than the System Utilities program does if you have a single 
UniDisk 3.5 drive connected. Quick Copy requires much less 
disk swapping. If you have more than one UniDisk 3.5 
connected, Quick Copy works at about the same speed as 
Duplicate a Disk in System Utilities. 

79 Chapter 5: Disk and Memory Reference 



Ejecting 3.S-inch 
Disks 

Disk II 

Using Switch Disks 

Use Quick Copy to make backup copies of your 3.5-inch disks. 

You cannot make a backup copy of your Catalyst Master or 
Backup disks with Quick Copy, because Catalyst is copy­
protected. 

Catalyst has two methods you can use to eject 3.5-inch disks. 
The Eject command (or OPEN APPLE-E) ejects the currently 
selected 3.5-inch disk. OPEN APPLE-SHIFT-1 and OPEN 
APPLE-SHIFT-2 eject the 3.5-inch disks in drives1 and 2. 

If you have more than two UniDisk cards installed (Apple lie only), 
the OPEN APPLE-SHIFT commands eject the 3.5-inch disks 
connected to the highest numbered slots. 

Catalyst does not update desktop information (like window size 
and location, precise icon positions, and scroll control settings) 
on the disk when you use the OPEN APPLE-SHI FT commands 
or the eject button on the drive itself. Catalyst does update 
desktop information when you use the Eject (OPEN APPLE-E) 
command. 

Disk II drives use flexible, or floppy, 5-114 inch disks as a storage 
medium. The built-in drive in the Apple IIc uses floppy disks, as 
do the external Disk II drives you may have attached to your 
system. 

You can copy any commercial ProD OS-based program from a 
floppy disk to a UniDisk 3.5 or other high-capacity disk using 
Catalyst. (Custom programs on floppies must be copied using a 
utilities program. See Appendix B.) 

The Switch Disks command on the Miscellaneous menu (or 
OPEN APPLE-S) produces icons on the desktop for all the 
floppy disks mounted in your Disk II drives. The command lets 
you identify a different floppy disk to Catalyst. 
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Hard Disks 

Backing Up 

IE Switch Disk lIS and then click OK. 

I 
1 ralh 

Unless you start up Catalyst from a floppy disk, you won't see any 
Disk II icons at startup. Use Switch Disks after you start up to 
show the floppy disk icons. Use Switch Disks any other time you 
want to switch disks and show their icons on the desktop. 

When you choose Switch Disks, you are asked to confirm. 
Remove one floppy disk, insert another, and click OK (or press 
RETURN). Catalyst displays icons for all the floppy disks you 
have in your drives. 

Hard disks, like Quark QC1 0, Quark QC20, and ProFile, provide 
mass storage on a medium with a single, rigid, high-capacity 
platter that usually can't be removed. Hard disks have varying 
storage capabilities, but usually store five to twenty times as 
much information as a UniDisk 3.5. 

The Backup II program on Catalyst lets you back up your hard 
disk after you have installed all your programs, as well as any 
other time you wish to make a backup of the hard disk 
information. 
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RAM Disk 

Show/Hide RAM Disk 

The Apple II Memory Expansion Card is a 256K high-speed 
cache memory card for the Apple lie. With the 256K Memory 
Expansion kits you can add up to one megabyte of storage to 
this card. The memory expansion card is generically referred to 
as a "RAM disk". 

Catalyst uses a special icon forthe Memory Expansion Card. 
Using the Show RAM Disk command in the Miscellaneous 
menu, you can make this icon visible. Catalyst treats non-Apple 
RAM disks as regular disks, and represents them with the 
generic disk icon. 

When you have a RAM disk card installed, Catalyst automatically 
moves its program code to the card at startup. Catalyst may 
move an installed program's code to RAM disk at startup or the 
first time the program is run. This depends on how the program 
is designed (if the program can't be moved to the RAM disk, the 
RAM disk buttons in the program's Get Info window are dimmed) . 

When you have more than one RAM disk card installed, the 
Catalyst commands work on the one in the highest numbered 
slot. Your other RAM disks appear as normal disks. 

The Show RAM Disk command in the Miscellaneous menu 
shows the RAM disk icon, and lets you treat the RAM disk like 
any other disk. You can copy programs onto RAM disk, get 
information about the disk with Get Info, and so on. 

When you open the RAM disk icon, its window is dark. This 
indicates that the contents of the window are special. When you 
select an icon in the RAM disk window, the icon becomes white. 
A program that is designed to work with the RAM disk may move 
only a subset of its programs and files in orderto maximize space 
use on the RAM disk. As a result, programs represented by 
icons in the RAM disk window may not be complete. 
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RAM Disk Control 
Settings 

I File Edit Miscellaneous 

a 
II:iI 

I 
I rosh 

Once you have chosen Show RAM Disk, the menu item changes 
to Hide RAM Disk. Choosing Hide RAM Disk hides the RAM disk 
icon and its window. 

Program Info windows for commercial (non-custom) programs 
contain control settings for RAM disks. The controls (buttons) 
are dimmed (gray) if the program isn't designed to use the RAM 
disk. A selected button, like the Copy at startup button for 
Catalyst System, looks like a bull's eye. 

Progr aM ~olu~le: CATALYST 

Progr aM title: BASIC 

PrefiH: II 
~--------------------~ 

COMMent: ~ 
ProDDS BASIC Interpreter (msion 1,1) 
Copyright 1983-84 Apple COMputer I Inc. 

AutOMatic RAM disk caching: 
Selected Button -------------1--1----+-00 Don't copy 0 Copy at start up 0 Copy on first use 

I 
I rosh 
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Starting Up With 
RAM Disk 

If the buttons appear as normal rather than dimmed text, you can 
select them. Click on the button if you have a mouse. If you 
don't have a mouse, press the TAB key to select a different 
button. 

When the Don't Copy button is selected, the program is not 
copied to RAM disk. 

When the Copy at start up button is selected, the program is 
copied to RAM disk when Catalyst is started up. 

When the Copy on first use button is selected, the program is 
copied to RAM disk when the program is executed. 

If you are using Catalyst with a Disk II drive and RAM disk, but with 
neither a UniDisk 3.5 nor other high-capacity disk attached, you 
can install your programs on RAM disk each time you use your 
computer. Doing this lets your programs start much faster, and 
may let your programs run faster. You have to re-install the 
program each time you start up, however. 
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Introduction The first part of this chapter describes the Catalyst 
desktop. It summarizes icons, the trash, windows, 
and printing screens. 

The second portion of the chapter provides reference 
material on each of the Menu commands. 

There is a brief summary of each of the programs on 
the Catalyst disk at the end of the chapter. 

For reference information on disks, see Chapter 5. 
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The Desktop 

Icons 

Trash 

The Catalyst desktop is the central organizing area you use to 
move, copy, install, remove, and edit information about your 
disks and programs. 

Catalyst keeps desktop information on each volume (disk). 
Catalyst stores and updates information on windows, the startup 
program, pathnames, and programs on the volume. 

You work on the desktop by selecting and dragging icons, 
windows, and buttons, and by choosing commands·from the 
menus. The procedures are different but all the desktop options 
are available for mouse and non-mouse users. 

A note on data files: The work you do with data files is 
handled within your programs. (You can't work directly with data 
files on the Catalyst desktop as you can on the Macintosh 
desktop.) When you save documents created with a program, 
you save them using whatever process the program provides. 

To see a directory (list) of data files on a disk, use the Filer 
command List ProDOS Directory. 

Catalyst icons represent volumes (disks), programs, and the 
trash. You can move (drag) icons around the screen, and copy 
programs by dragging their icons into other disk icon windows. 
You use the icons to open disks and programs with Catalyst. 

The trash icon represents a desktop wastebasket. You can 
remove programs and disks from the desktop by dragging their 
icons into the trash. Catalyst automatically updates a volume's 
desktop file when you use the trash. 

Putting a disk icon in the trash removes the disk contents from 
the computer's memory (it doesn't erase the disk). When you 
drag a UniDisk 3.5 icon onto the trash, it's contents are removed 
from memory and the disk is ejected. 

Once you have installed a program, putting a program icon in the 
trash removes (deletes) the program from the disk. Catalyst 
alerts you, and asks if it's OK to throwaway. (However, Catalyst 
won't let you throwaway a program that is on the original disk you 
bought, or a volume copy of it.) 
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Windows 

When you drag a custom program into the trash, Catalyst alerts 
you that the files associated with the program won't be deleted. 
Only the program icon is deleted. You have to use a utilities 
program to throwaway the files. 

You cannot open the trash icon. It is there for you to discard 
things when you are running out of space on a particular disk, 
when you no longer use a program, or when you are finished 
using a disk. 

If you don't have a mouse, use Discard Disk ... and Delete 
Program ... instead of the trash. 

Catalyst windows present information. You can have multiple 
windows on your desktop at once. Disk windows can be moved, 
changed in size, scrolled though, and closed. 

Windows can overlap each other. When you want to work in a 
window, you move it to the front--that's where the action takes 
place. The active (front) window is indicated by the close box 
and stripes (horizontal lines) in the title bar. Windows that aren't 
active contain only a title in the title bar. 

You can't drag a window completely off the screen or shrink it 
beyond a certain size. 

To select a control button for RAM disk settings in a Program Info 
window, click on the button. If you don't have a mouse, press 
the T AS key to select a different button. 

I File Edit Miscellaneous 
CATALYST [d 7 frOjrOMl m uled 1168 fr ee 

CAIALYSI <£t ~ <~ <~~, 
v 'v ' 'v' 

~lov sePoint !jsteM Ut ilities 1'-'-"...........,.....,.....,.-:----, 

....... ,.... / ..... . 

MY,DISK 
1 fl'OjrOI~ 195 used 
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1 prOjrOM 195 used 

Puzzle 
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Dialog Boxes 

Editing Text 

Catalyst dialog boxes request information. When a dialog box is 
open you must respond to the information request or cancel 
before you can do anything else on the desktop. Dialog boxes 
can't be moved, and they generally have buttons that give you 
choices-to OK or cancel, for example. 

To accept the selection in a dialog box, press the RETURN key 
orclickonthe OK, Run, Copy, Delete,orDiscard 
button. To select Cancel, press the ESC key or click on Cancel. 

To make a selection in a dialog box list (either a list of programs or 
a list of volumes), click on the item or use the arrow keys to 
highlight it. Click on the appropriate button or press RETURN to 
proceed. 

Progr aMS on CATALYST 
BASIC 
Backup / / 

Run a PrograM 

i 
lrosh 

You can edit text in dialog boxes whenever you see rectangular 
text boxes. The Program Info and Add Program dialog boxes 
contain such text boxes. 

If a text box is highlighted, what you type replaces its 
contents. 

If a text box isn't highlighted, press TAB or click with the 
mouse to move the blinking bar insertion point to the box. 
Then type to insert text. 

Use TAB or click with the mouse to move through the text 
boxes. 
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Printing the Screen 

• Click with the mouse or use the RIGHT and LEFT arrow keys 
to move the blinking bar insertion point within a text box. 

Use the DELETE key to delete a character to the left, 
CONTROL -F to delete a character to the right, CONTROL-X 
to delete all characters on the line, and CONTROL -Y to delete 
from the cursor to the end of the line. 

• To select (highlight) a range of text with a mouse, drag on it. 
(You can't select a range of text without a mouse.) Then use 
the keyboard equivalents (OPEN APPLE-X to cut, OPEN 
APPLE-C to copy, OPEN APPLE-V to paste, OPEN APPLE­
Z to undo) to work with the selected text. 

Proqrafll Info 
I ,rOjr Proqr aM ~oluMe: CRTRl YST 

10 I Proqml title: HousePaint 
zo L 
,,0 G PrefiH: 

cA 
Comment: 

HousePaint (msion l,ll 
Copyright 1985 Rpple COMputer 

lM'l1'H~i( F:fWI >1i :; I: [,;[hint!: 
o [j'HI'j; [['PI! 0 G(I P'~ ,I i:, ~i'l;,ll .. t 1.11" 0 [:1)1:'1:1 ']11 Fir'!::I:, IJ:;':! 
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Catalyst has a built-in screen-printing capability. Press OPEN 
APPLE-SHIFT-4 to print the Catalyst screen to an Imagewriter or 
Scribe printer connected to the printer port (lic) or Super Serial 
Card in slot 1 (Apple lie) . 

You cannot print a Catalyst screen if you have clicked in a control 
button or scroll control and are still holding down the mouse 
button. You may be able to print the screens of other programs 
w~h OPEN APPLE-SHIFT-4, but it depends on the program. 
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Apple Menu: 
Desktop 
Accessories 

About Catalyst. .. 

Calculator 

l m file Edit-Miscel!ineoU"$------------------------------------i 
'1About Catalyst.., 

Calculator 
Chanqe Desktop 
Clock 
Puzzle 

The commands on the Apple menu give you access to desktop 
accessories like a calculator and clock. Once you have opened a 
desktop accessory, its window stays open until you close it. 

QUClrk™ 
Catalgst (version 3,0) 

Serial ~8 

©Copyright 1982-85 O.mk Incorpor ated 

About Catalyst. .. gives you version, serial number, and copyright 
information about the Catalyst program. 

Click on the Cancel button to close the window, or press ESC. 

§D= Calculator = 

I' 

The Calculator works like a four-function pocket calculator. 

Click the buttons with the mouse ortype on the keyboard. 

The + key is addition; the - key is subtraction; the * key is 
multiplication; the / key is division. C is clear; E is for scientific 
notation. 

Click on the close box or press CONTROL -C to close the 
calculator if it is the active window. 
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Change Desktop 

Clock 

Change Desktop lets you switch from one of the 10 different 
desktop background patterns to another. 

When you start up Catalyst, the desktop always comes up with 
the gray pattern. Each time you choose Change Desktop, you 
see a new pattern. Continue to choose Change Desktop until 
you find the pattern you like best. 

The clock lets you see the date and time if you have a ProDOS 
compatible clock installed in your Apple. If you don't have a 
clock, the Catalyst clock image can't show the date and time. 

The Thunderclock TM displays date, hour, minutes, and seconds. 
Other clocks may show only date, hour, and minutes. 

The clock remains on the desktop until you close it. Click on the 
close box or press CONTROL-C to close the clock if it is the 
active window. 
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Puzzle 

File Menu 

Open 

;0= Puzzle === 
3 II 2 14 

II 10 7 9 

4 5 8 6 

13 I 15 12 

The puzzle gives you a little entertainment when you need a 
short break. The object is to rearrange the numbers in order as 
quickly as possible. Click a tile to slide it into the empty space. 

The puzzle rescrambles whenever you open it. Click on the 
close box or press CONTROL -C to close the puzzle if it is the 
active window. 

Open 
Get Inf a iI 
Run PrograM ... IR 

Close +C 

Eject IE 

Ouit '0. 

The commands on the File menu let you manage the disks and 
programs you use with Catalyst by opening, running, closing, 
and getting information about them. You also can choose to 
eject a disk with this menu. 

Opens the window of a selected disk icon and displays the 
contents of the disk in the window. If a disk window is already 
open when you select the Open command, the window is 
activated. 

The Open command starts up a program when you have 
selected a program icon. Catalyst alerts you when a program (like 
Catalyst System) can't be opened or run. 

1m This is a non-eHecutable prograr.r. 
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Get Info Opens a window that displays information about the selected 
icon. 

Disk Info windows identify a disk's title (Vo l ume n ame), location 
(Vol ume mou nted i n ... ), disk type, the name of the startup 
program (if any) , and the amount of storage on the disk. 

There are two types of Program Info windows: those for 
commercial programs and those for custom programs. 

The Program Info window for commercial programs includes 
program volume, title , prefix, and comments written by the 
developer. You may be able to edit the prefix; unless the 
program's manual discusses how to change the prefix setting, it's 
not advisable to do so. The Program Info window also includes 
three control settings (buttons) for RAM disk use. The Automatic 
RAM disk caching status buttons let you load a program into RAM 
on a memory expansion card, either at startup or the first time you 
use the program. See "RAM Disk Control Settings" in Chapter 5 
for more information. 

The Program Info window for custom programs lets you identify 
program volume, title , system file name, prefix, and program 
path. When you install a custom BASIC, Logo, orother ProDOS­
compatible program, you fill in (and can edit) the information that 
appears in the program's information window. See Appendix B, 
"Adding Custom Programs," for more information. 

You can use OPEN APPLE-I from the keyboard as a shortcut to 
Get Info on any selected icon. 

Proqmllnfo 

COllllllent: 
HousePaint (~ers ion 1,1) 
Copyriqht 1985 Rpple COIIIPuter 

l'ilJ't'lI"I ,l'~i( lUW! ,k i!: L:i:lL:hiflg: 
o \] 'l l1 ' t [[If'~1 0 C(I P':I i~ i: , :;'i;,li"t up 0 [:1)f'9 ']11 fir ~: I:, Ij:, >! 

95 Chapter 6: Catalyst Reference 

I 
1 rash 



Run Program ... 

Close 

Close a Get Info window by clicking on the close box or pressing 
CONTROL -C (you can't choose Close from the File menu when 
a Get Info window is open). 

Lets you run programs easily when you don't have a mouse. 
When you choose Run Program ... , you see a list of programs on 
the selected disk. By pressing OPEN APPLE-N , you can see a 
list of programs on each of the other disks you have in your disk 
drives. 

If you don't have a mouse, use the arrow keys to highlight the 
program you want to run. Press RETURN to run the program. 

If you do have a mouse, scroll through the programs with the 
scroll bar. Double-click on a program to run it; or select the 
program and click on the Run button to run ~. 

Run Program ... does not show "non-executable" programs. If 
there are no programs on a disk that can be executed, it skips 
the disk. If no disks in your drives have programs that can be 
executed, the command is dimmed. 

You can use OPEN APPLE-R from the keyboard ratherthan 
choosing the command from the menu. 

Progr aMS on CATALYST 
BASIC 
Backup I I 

I ~louse~alnt 
Quick Copy 
SysteM Utilit ies 
Word Juggler 

Run a PrOgraM 

I:Q-
r [ Run ~ Slot 7, Ori~e I 

I I , .. ,,' I 'N .. , Di'kiN) 
D-

Closes the active (front) window, zooming ~ back into ~s icon. 
The icon remains selected. When you close desktop 
accessories, they simply disappear. 

CONTROL-C also closes any active window. 
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Eject 

Quit 

Edit Menu 

Ejects the currently selected 3.5-inch disk. When you eject a 
disk, Catalyst dims the disk icon and the program icons within it to 
show that the disk is no longer available. 

If you try to eject a hard or floppy disk, Catalyst updates its 
desktop file but otherwise ignores the command. 

OPEN APPLE-E also ejects the current disk. 

Updates all the desktop files and quits Catalyst. You see the 
message 

Press OPEN APPLE CONTROL RESET to reboot. 

OPEN APPLE-Q also quits Catalyst. 

r I file IHJlIII 

[ut. 11: 1,: 
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Show Clipboard 

The commands on the Edit menu let you edit text in separate 
desk accessory products. The manuals for these accessories 
explain edit commands in more detail. 

You can also edit some fields in the Program Info windows. Use 
the keyboard equivalents for Edit commands to edit fields in 
these windows (you can't pull down the Edit menu while the 
Program Info window is visible). 

Because you cannot select a range of text without a mouse, you 
cannot use Cut, Copy, Paste or Clear. The Clipboard remains 
empty because you can't cut or copy without a mouse. 

When the edit commands are not available they are dimmed. 

To edit text within a program, you must use the editing facilities in 
the program. 
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Undo 

Cut 

Copy 

Paste 

Clear 

Show Clipboard 

Undoes your last text-editing action. If you decide you don't 
want to undo, choosing Undo again restores your original text. 

OPEN APPLE-Z performs the Undo command from the 
keyboard. 

Removes the selected text and places it on the Clipboard (see 
Show Clipboard), replacing any previous Clipboard contents. 

You can undo or paste cut text, providing you choose one of 
these commands directly after the cut. 

OPEN APPLE-X performs the Cut command from the keyboard. 

Places a copy of the selected text on the Clipboard, replacing 
any previous Clipboard contents. 

You can undo or paste copied text, providing you choose one 
of these commands directly after the copy. 

OPEN APPLE-C performs the Copy command from the 
keyboard. 

Puts a copy of the Clipboard contents at the insertion point. 

OPEN APPLE-V performs the Paste command from the 
keyboard. 

Clears, or deletes, a range of selected text. 

The Clipboard is a holding place for whatever you most recently 
cut orcopied in a text editing operation. Show Clipboard 
displays a window with the current Clipboard contents. 
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Miscellaneous 
Menu 

Set/Clear Startup 

Switch Disks 

[i File Edit 
IIClear Startup 

Switch Disks is 
Show RAH Disk 

Add ProqraM", 
Copy PrOqraM", 
Delete PrOqraM", 
Discard Disk", 

1 

The commands on the Miscellaneous menu let you set an 
automatic startup program, switch disks, and show or hide the 
RAM disk icon. This menu also lets you easily add, copy, and 
delete programs, and discard disks, when you don't have a 
mouse. 

Set Startup sets the selected program as that disk's automatic 
startup program. Once you have set a startup program on a 
particular disk, Catalyst runs the program automatically each time 
you start up with that disk in one of the drives. 

Catalyst searches for a startup program each time you start up 
your computer. Catalyst looks first in the startup drive; then it 
searches through the disks connected to your Apple in 
descending numerical order, beginning with the highest 
numbered slot (port). 

Clear Startup deselects the startup program on a selected disk. 

If you need to bypass a startup program-if, for example, you 
don't want to use your usual startup on a particular day-press 
and hold both the OPEN APPLE and SOLID APPLE keys as 
soon as the gray Catalyst desktop appears. Eventually Catalyst 
displays a note box saying that the startup program is aborted. 

Shows icons for all the floppy disks mounted in the built-in or 
other Disk II drives, and lets you identify a change of floppy disks. 

To use the command, choose Switch Disks (OPEN APPLE-S). 
Change disks. Click on OK or press RETURN. Catalyst displays 
the icons of all floppy disks in your drives. 

If you start up Catalyst from a floppy disk, its icon is displayed. 
You must use Switch Disks to show icons for any other floppy 
disks you have in drives at startup. Use Switch Disks any other 
time you want to use a different floppy disk and show its icon on 
the desktop. 
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Show/Hide RAM Disk 

Add Program ... 

You do not need to use Switch Disks when you change 3.S-inch 
disks; you'll see the icon appear automatically. 

Displays the RAM disk icon and opens its window. The RAM disk 
window is black, to distinguish it from other windows. 

The menu changes to Hide RAM Disk once you have shown it. 
Selecting Hide RAM Disk hides the disk icon and its window 
again. 

Whether or not you choose Show RAM Disk, Catalyst always 
moves its program code to the RAM on the memory expansion 
card (if you have one) at startup, and may move other programs 
to the RAM as well. You can use the Get Info command on a 
program to control whether the program code is moved to RAM. 

If you have more than one RAM disk installed, Show RAM Disk 
refers to the one in the highest numbered slot; the other RAM 
disks appear as normal disk icons. 

If you have a RAM disk that is not Apple's Memory Expansion 
Card, it appears as a normal disk icon, and does not take 
advantage of the special caching available with the Apple II 
Memory Expansion Card. 

Displays a series of dialog boxes for adding information about 
custom programs you are installing with Catalyst. Add Program ... 
lets you choose the volume you want to add the program to, and 
then name the program title, system file path, prefix path, and 
program path. 

If you don't have a mouse, use the arrow keys to highlight the 
volume you want to add to, and press RETURN. If you have a 
mouse, double-click on the volu me you want to add to. Fill in the 
program information fields, pressing TAB to move to the next 
field. Click on the OK button or press RETURN when you have 
finished filling in the text fields. 

See Appendix B for more information about adding custom 
programs. 
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Copy Program ... 

Delete Program ... 

Discard Disk ... 

Lets you easily copy a program from one disk to another without 
a mouse. 

Copy Program ... displays a series of dialog boxes that let you 
choose from a list of programs on a disk, view a list of programs 
on a different disk (OPEN APPLE-N), choose the volume you 
want to copy to, and complete the copy or cancel it. 

You can copy a custom program icon, but not its files, with this 
command. Catalyst notifies you if a program's files can't be 
copied. 

Lets you easily delete a program from a disk without a mouse. 
Delete Program ... is useful when you are running out of space 
on a particular disk or no longer use the program. 

Delete Program ... displays a series of dialog boxes that let you 
choose from a list of programs on a disk, view a list of programs 
on a different disk, and complete the deletion or cancel it. 

You can delete a custom program icon, but not its files, with this 
command. Catalyst notifies you if a program's files can't be 
deleted. 

Lets you remove a disk from the desktop without a mouse. 

A dialog box displays a list of the volume names to select from. 
When a disk (volume) is selected, you can discard the disk or 
cancel. 
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the Catalyst 
Disk 
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System Utilities is a ProDOS-based program that gives you 
control overthe information you keep on your disks. You can 
initialize, copy, delete, and organize your disk files with System 
Utilities. The System Utilities program on the Catalyst disk is the 
most recent version of the program; use it rather than any other 
versions you may have. Appendix A, "Using System Utilities 
With Your UniDisk 3.5," has more information. 

The Filer is another version of Apple's ProDOS utilities. The 
Filer lets you initialize, copy, delete, and organize your disk files. 
It also lets you easily rename individual files and whole disks. 
The Filer program on the Catalyst disk is the most recent version 
of the program; use it rather than any other versions you may 
have. 

A Note for UniDisk 3.5 users: You should use the Filer 
program only for renaming volumes. Use the System Utilities 
program for other utilities functions. 

Quick Copy lets you make copies of ProDOS disks fasterthan 
the Filer or System Utilities. It is especially useful for copying 3.5-
inch disks orfloppy disks with a single drive connected, since 
fewer swaps are required. Follow the instructions on the screen 
to use Quick Copy. 

MousePaint is an Apple program that lets you dr.aw pictures 
and designs with the mouse and print them. The AppleMouse II 
User's Manual that came with your mouse explains how to use 
MousePaint. 
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BASIC is Apple's ProDOS-based programming language. The 
Applesoft Tutorial and Applesoft BASIC Programmer's 
Reference Manual (2 volumes) explain programming with BASIC. 

Backup II is an Apple program that lets you back up your hard 
disk files. The Backup II manual that comes with Apple's ProFile 
explains how to use the program. 
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Appendix A: 

Using System 
Utilities With 
Your UniDisk 
3.5 

This appendix describes how to use the Apple II System Utilities 
program with a 128K Apple lie or IIc and your UniDisk 3.5 disk 
drive. Before you use this appendix, you should have read your 
Apple UniDisk 3.5 Owner's Manual and installed your UniDisk 
3.5. 

Note: System Utilities is an Apple product. If you need 
technical support, contact your Apple Dealer. Quark cannot 
provide technical support for System Utilities. 

The UniDisk 3.5 enables you to store your programs and data 
onto 3.5-inch , double-sided disks with 800 kilobytes (K) of 
storage capacity. Detailed instructions for copying Apple 
programs, including AppleWorks, Apple Writer II , and Apple 
Access II, are available from your authorized Apple dealer. 

The UniDisk 3.5 will enable you to store almost six times as much 
data on a single 3.5-inch disk as you can store on a 5 1/4-inch 
disk. Because you can store so many more files, keeping track 
of what file is on which disk can become a challenge that the 
System Utilities can help you meet. The System Utilities can also 
help you keep your disk files easily accessible, better organized, 
and protected. This appendix explains some important 
techniques for naming files on large-capacity disks such as the 
UniDisk 3.5 or hard disks such as the Quark QC1 0, Quark QC20, 
and ProFile. 

You can use the System Utilities along with your programs to do 
such things as 

• format disks 

• organize related files through the use of subdirectories 

• copy data files from one disk to another 

• rename files 

• delete files 

• copy files or entire disks for backup 

• list the names and characteristics of files on the disk 

• check disks to verify that they are usable 

In this appendix, you will learn more about these functions and 
how they can be used to help manage your disk files. 
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Techniques for 
Disk File 
Management 

One of the most important functions of the System Utilities is the 
preparation, or formatting , of your UniDisk 3.5 disks. Many 
current programs have built-in utilities that cannot format 3.5-inch 
disks. You can use the System Utilities to format severaI3.S­
inch disks so that you will have a supply of formatted disks ready 
when you need them. 

Managing your disk files depends upon your taking the time to 
follow certain procedures, many of which make use of the 
System Utilities. Some suggestions for disk file management 
include: 

Take time to organize your data files. You are often hurrying 
to finish a task or to try just one more operation on the 
computer. Realize the importance of managing the 
information on your disks, and take the time to do it. 

Save your work frequently. Power failures, for example, can 
cause you to lose hours of effort. Your application program 
will tell you how to save data files. 

• Make backup copies of your programs. The System Utilities 
can make copies of entire disks or specific files. 

• Make backup copies of your data files at regular intervals. It's 
important to make backup copies whenever you make 
significant changes to data files. Make backing up your data 
files a part of your regular routine. 

• Alternate between two disks when you make a backup copy. 
If, for example, you use two disks for backup, you can use the 
first disk the first time you make a backup copy. The next time 
you back up, use the second disk; then use the first disk 
again, and so forth. If something goes wrong in the backup 
process, you still have the alternate backup copy. 

• Lock important files. The System Utilities allows you to lock 
files so they can't be deleted or changed accidentally. File 
locking is especially important if other people use your files. 

Write protect your important disks. For a 3.5-inch disk, write­
protection (physically preventing the disk from being written 
on accidently) is very simple. Turn the disk over, locate the 
small plastic tab in the upper left corner, and slide the tab up 
so that the small hole in the disk is uncovered. To write on 
the disk, slide the plastic tab down to cover the hole. 
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Structuring Your Data 
Files 

• Label disks clearly. Use colored labels or colored felt-tip 
pens to code related disks or backup disks. 

Your information is valuable and you must take precautions to 
protect it. It may take you longer to recreate the information than 
it took to create it, since you may not have easy access to the 
original source. If you lose information, you lose time and effort. 

If you use your computer in a business enterprise, protecting 
your data becomes even more important. The information 
becomes an asset to the business and part of its efficient 
operation. 

If you are accustomed to using 5 1/4-inch flexible disks, you 
probably organize related data files by keeping them on one 
disk. Using the UniDisk 3.5, a single 3.5-inch disk can hold the 
equivalent of about six 5 1 14-inch disks. With this large capacity, 
you need another approach to organizing your files. This 
method of file organization relies on the use of names and 
special files, called subdirectories, that allow you to group related 
files. 

Subdirectories, volumes (disks) , and files all follow the same 
rules for naming. You can make up any name you like, within the 
guidelines listed below. 

Names must begin with a letter. 

Names must be made up of only letters, numbers, and 
periods. 

• Names can have no spaces or punctuation other than 
periods. 

Names cannot have more than 15 characters. 

You may find these tips useful in making up names. 

• Keep the name as short as possible to reduce typing. 

• Choose a short name that suggests the contents of the file. 

• Start the names of related files with the same few letters 
(many utilities and programs display lists of file names 
alphabetically, so the names of related files will be shown 
together). 
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Subdirectories, 
Pathnames, and 
Prefixes 

Include the date or time as part of the filename if you need to 
indicate varying versions of the same information. 

If several people use the same disk, create a separate 
subdirectory file for each person, perhaps using the person's 
name as the name of the subdirectory. These subdirectories 
will keep everyone's files separate and lessen the likelihood 
of two people using the same filename. 

The key to this method of organizing files on large-capacity disks 
is the subdirectory. A subdirectory is a special file containing the 
names of other files, usually files that are related in some way to 
each other. . 

For example, if you keep some data files for your business 
records and others for your home records, you can create one 
subdirectory for the names of your business data files and 
another for the names of your home data files. Using 
subdirectories, you can work with just those data files you 
want-those for either business or home-rather than with every 
file stored on the disk. Subdirectories, then, are a way to group 
related files. The System Utilities will help you create 
subdirectory files and copy related files into particular 
subdirectories. 

To refer to a particular group of files, you must tell the computer 
the name of the disk (or volume) where the files are stored and 
the name of the subdirectory where the computer can find the 
names of the files in which you're interested. To use a particular 
file, you simply add the file's name to the volume and 
subdirectory names. This sequence of names is called a 
pathname. A pathname is made up of the volume (or disk) 
name, one or more subdirectory names, and the file name, with 
each name separated by slashes. 

On a particular disk (volume), for example, you may have two 
subdirectories-one for business and the other for home. Each 
of the two subdirectories can contain the names of other 
subdirectories-one for word processing files, another for 
spreadsheet files, and another for database files. The names of 
the actual files containing the information can be saved in these 
six subdirectories. 
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You might want to work with a letter that you wrote to your Aunt 
Tillie. To get to the file that contains the letter, you must indicate 
the path through the subdirectories: 

MYVOLUMEIHOMEILETIERSI AUNTIlLLIE 
I I I II I 
disk or subdirectory filename 
volume name names 

Each name is separated by a slash and indicates the path to the 
particu lar file. 

Subdirectories help you keep track of your disk files, making it 
easier and faster to gain access to them in programs. When you 
want to use a file in a program, such as AppleWorks, you must 
choose the file from a list of AppleWorks files on the disk. By 
grouping related files, subdirectories focus your view of the files 
on the disk. Instead of having to select from a list of every file 
stored on the disk (when you're using the program), you see 
only the names of those files in which you are interested. 

When programs ask you to type the name of a file with which you 
want to work, you can type the entire pathname. But the 
pathname is often long, which makes typing difficult. Programs 
allow you to save part of the pathname as a prefix. The part of 
the path name that you set as a prefix will be attached 
automatically to the left of any name you type. Whenever you're 
using a particular group of related files pointed to by a 
subdirectory, it's helpful to set the prefix to include the 
subdirectory name to point to just that group. 

Using the example above, if you set the prefix to 

IMYVOLUMElHOMEILETIERSI 

you would then just type the name of the file-AUNTIlLLIE-to 
load the file containing the letter to Aunt Tillie. The prefix would 
be attached to the left to form the entire pathname. 

Setting the prefix lets you look at just the group of files with 
which you want to work. If you set the prefix as above and then 
get a listing of files, the list would contain only those files within 
the pathname IMYVOLUMElHOMEILETIERS/, not every file on 
the disk. Later you can change the prefix so that you can look at 
another group of files. The prefix makes working with large­
capacity disks much easier. 
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Operating System 
Utilities 

Selecting From Menus 

The easiest way to learn how to use the System Utilities is 
actually to use them. You will see most of the necessary 
instructions right on the screen. You start upSystem Utilities by 
opening the program from Catalyst. The sections below give 
general information about using the System Utilities. 

If you need instructions for using any menu, you can press 
OPEN APPLE - ? to get some additional help. 

Note: If you are using a non-Apple hard disk, some help 
messages may not be available to you. 

The System Utilitiesfunctions are easy to use. Menus (lists of 
options from which you may choose) present the utility 
commands. You simply select what you want to do from the 
menu by using the UP ARROW or DOWN ARROW to point to 
the function you want, and then you press RETURN. 

The System Utilities asks you for any additional information 
through other menus and prompts (reminders to the user that 
some information or action is expected). You will also see 
instructions displayed on the screen for you about how to use 
each menu. 

To select options presented on a menu, use the UP ARROW 
and DOWN ARROW keys until you point to the option you want. 
The option changes to uppercase letters and is enclosed in 
angled brackets: <>. Then press RETURN to select that option. 

The System Utilities also asks you if you want to work with some 
or all of the files (files you want to copy, list, or delete, for 
example). If you choose SOME files, the System Utilities 
displays a list of file names from which you may choose. Again, 
you use UP ARROW and DOWN ARROWto locate your choices. 
When selecting from a list of files, use th6 RIGHT ARROW key to 
select a file (shown on the screen as a...J when you press the 
RIGHT ARROW key) or the LEFT ARROW key to remove the ...J if 
you change your mind. 

If you have a large number of files listed, they will be displayed in 
two or more columns. You can use the TAB key to move from 
column to column as you make your filename selections. 

When you have selected and marked all the files with which you 
want to work, press RETURN, and watch the screen as 
messages are displayed telling you what is happening. 
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Changing Default 
Names 

Indicating the Disk 
Location 

If a utility asks you for a name, it will usually provide a default 
(suggested response) for you. You can use the default name by 
pressing RETURN. 

If the name is a volume name, you can change it simply by typing 
a new name. If the name is a pathname, and you have previously 
set a prefix, you can add to the prefix by typing a name, or you 
can change the prefix by beginning the name with a slash. 

You can edit any default name by using the LEFT ARROW and 
RIGHT ARROW keys to position the cursor and insert new 
characters. You can use the DELETE key to delete characters to 
the left of the cursor. Pressing CONTROL-Y deletes all the 
characters to the right of the cursor. Pressing CONTROL-X 
deletes all characters (so you can start typing a new name). 

Press RETU RN when you have finished entering or editing the 
name. 

Some utility options ask you to indicate the physical location of 
the disk containing the files with which you want to work. How 
you indicate the location depends on whether you are working 
on an Apple IIc or an Apple lie. The System Utilities determines 
which computer you are working with and displays menus 
appropriate to that computer. 

On the Apple lie, when you are asked to identify the location 
of a disk, you see a menu such as the one below. (The menu 
options vary depending on the disk drives you have attached to 
the computer.) 

Where is your source disk? 

1 . Built-in Drive 

2. External DISK 3.5 #1 

3. External Disk / / c 

4. ProDOS Pathname 

On the Apple IIc, you can identify the location of a disk by 
selecting one of the first three options listed in the example 
above to show the actual disk drive where the disk is located, or 
you can specify a pathname and let the computer locate the disk. 
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Escaping and Quitting 

Remember! You must use the ProDOS Pathname (the last 
option in the example above) if you are working with specific files 
in subdirectories. 

On an Apple lie, when you are asked to indicate the location 
of a disk, you see a menu such as this: 

Where is your source disk? 

1. Slot and drive 

2. ProDOS Pathname 

To specify the location of the disk by Slot and Drive, you 
must know how your disk drives are attached to your computer, 
that is, in which slot the disk drive controller card is located. The 
easiest way to determine the slot number is to turn off the power, 
remove the cover, and look at the number of the slot containing 
the disk controller card. The recommended slot for 5 1/4-inch 
drives is 6. Forthe UniDisk 3.5, the recommended slot is 4. Slot 
5 is recommended forthe ProFile. 

Note: After you have your programs converted to the UniDisk 
3.5, you may want to move the UniDisk 3.5 controller card to slot 
6 and the controller card for your 5 1/4-inch drives to slot 4. The 
computer will then start up automatically from the disk in the 
higher numbered slot when you turn on the power. 

After you select Slot and Drive, you will be asked to enterthe 
slot number and the drive number containing the disk you want 
to specify. You will also see suggested responses of slot 6 and 
drive 1. You can change these defaults by typing a new number 
or accept them by pressing RETURN. 

If you use subdirectories, you must use the ProDOS Pathname 
option. 

You can use the ESC key to return to a previous menu or to stop 
a utility at the first opportunity. 

When you finish using the System Utilities, select the last option 
onthe Main Menu: Exit System Utilities. You will be 
asked if you are sure you want to exit. Pressing RETURN will 
select YES, and you will exit to Applesoft BASIC. Selecting NO 
will return you to the System Utilities Main Menu. 
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System Utilities 
Functions 

Copy Files 

Delete Files 

Rename Files 

The following sections describe the various functions performed 
by the System Utilities. You may want to try each function as you 
read about it. 

Copy Files lets you copy a file or files from one disk to another 
or from one subdirectory to another on the same disk. It comes 
in handy when you want to share data or programs with friends or 
business associates orwhen you want to organize related files 
into the same subdirectory. 

(If you want to copy all the files from one disk to another disk of 
the same size, you're better off using the Duplicate a Disk 
option.) Make sure your destination disk has the same format as 
you r sou rce disk (Pro DOS, DOS 3.3, or Pascal). 

When copying files from or to a subdirectory, you must indicate 
the location of yourfiles using the ProDOS Pathname option at 
the prompt forthe source and destination disks. You can copy all 
the files pointed to by a subdirectory simply by copying the 
subdirectory name. If you are copying files to a subdirectory from 
a list of files that also contains the name of the same subdirectory 
(indicated by a slash following the name), be careful notto select 
the subdirectory name from that list (because you don't want to 
copy the subdirectory into itse~). 

Delete Files lets you permanently erase files that have 
outlived their usefulness so you can reuse the disk space. (If 
you want to delete everything on a disk, use the Format a Disk 
option.) 

If you are deleting files from a subdirectory, you must indicate the 
location of the files using the ProDOS Pathname option when 
you are asked Where is your disk? 

You cannot delete a subdirectory unless all the files in that 
subdirectory have been deleted first. If you try to delete a 
subdirectory with files in it, you will get the message 
Subdirectory is locked. 

Rename Files lets you rename a file without changing its 
contents. 

If you are renaming files in a subdirectory, you must indicate the 
location of the files using the P roDOS P a thname option when 
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Lock/Unlock Files 

Duplicate a Disk 

Format a Disk 

you are asked Where is your disk? 

Note: To rename a volume, use the Duplicate a Disk 
option. If you know Applesoft BASIC, you can rename a volume 
with the Rename command. 

Lock/Unlock Files lets you lock files so you don't delete 
them, rename them, or change their contents by mistake. If 
you're sure you want to delete or aner a locked file, you can also 
use this option to unlock it. 

If you are locking or unlocking files in a subdirectory, you must 
indicate the location of the files using the P roDOS P a thname 
option when you are asked Where is your disk? 

Duplicate a Disk lets you make an exact copy of a disk. This 
option is one of the most useful, because you need to make 
backup copies of disks as insurance against their loss. 

Note: You cannot use Duplicate a Disk between various­
sized disks, as, for example, in duplicating a 51/4-inch diskto a 
3.5-inch disk. You must use the Copy Files option to copy 
disks of various sizes. 

Format a Disk lets you divide the magnetic surface of the disk 
into sections where information can be stored. You can't store 
information on a blank disk until it has been formatted. Format 
a Dis k is an important function of the System Utilities since 
many programs that have buin-in formatting options cannot 
format your UniDisk 3.5 disk. 

How a disk is formatted depends on which operating system you 
want to use. The Format a Disk option will ask you to select an 
operating system, or the program will determine one for you . 

If you format a disk that you've previously used and no longer 
need, the utility will ask Is it okay to destroy the disk? 
Type y to format the disk or N if you've made a mistake and have 
the wrong disk in the drive. 

Remember! When you format a disk everything stored on the 
disk will be destroyed. Don't ever format the Catalyst Master or 
Catalyst Backup disk. 
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Identify and Catalog a 
Disk 

Advanced 
Operations 

Create a Subdirectory 
(ProDOS Only) 

The only time you don't have to format blank disks before you 
usethem is when you use the Duplicate a Disk option. 
Duplicate a Disk formats the destination disk before copying 
information onto it. 

Identify and Catalog a Disk displays the contents of a 
directory on a disk. In addition to telling you which files are in the 
directory, Identify and Catalog a Disk tells you the disk's 
operating system, the disk's name (or number, in the case of 
DOS 3.2 or DOS 3.3 disks), each file's type, each file's size, the 
number of files on the disk, the number of blocks or sectors 
taken up by the files, and how many blocks or sectors are 
available on the disk. 

When using subdirectories, you will see files with a file type of 
D IR. These subdirectory files contain the names of other files. In 
order to see information on the files pointed to by the 
subdirectory files using Identify and Catalog a Disk, you 
must respond to the prompt Where is your disk? by using 
the P roDOS P a thname option from the menu and typing the 
pathname to include the subdirectory name. 
You will then see only those files pointed to by the subdirectory. 

Additional utility functions are available on the Advanced 
Operations menu. To get to the Advanced Operations menu, 
select Advanced Operations from the Main Menu, and press 
RETURN. 

If your disk is ProDOS-formatted, you can create subdirectories 
to group related files. Before you can put files in a subdirectory, 
you must use this option to create the subdirectory. Then you 
can use the Copy Files option to copy files into the 
subdirectory. 

Once you have organized your files into subdirectories, you 
must always refer to the files by the P roDOS P a thname-instead 
of the location of the disk-to get to your file. 

If you're going to be using files within the same subdirectory for a 
while, you can save typing time by setting a prefix. See "Set the 
Prefix (ProDOS Only)" below. 
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Set the Prefix (ProDOS 
Only) 

Verify That a Disk Is 
Readable. 

Change a Disk's Format 
(DOS Users Only) 

Configure the Serial 
Ports (Apple lie Only) 

Note: Some programs will let you create a subdirectory from 
within the program. 

Set the Prefix lets you store the first part of a path name (the 
volume name and any subdirectory names) in the memory of the 
computer so you can access files in that subdirectory simply by 
typing the rest of the pathname (usually just the filename). 

Setting the prefix is very useful when you want to work with a 
particular group of files pointed to by a subdirectory. Setting the 
prefix focuses your view (and the operation of other utility 
functions) to just that group of files. 

Once you set the prefix, it stays set until you change it, turn off 
the computer or start another program. 

Note: Some programs allow you to set the prefix from within the 
application. 

Verify That a Disk Is Readable checks to see if a disk is 
OK. Use Verify That a Disk Is Readable to check newly 
formatted disks before entrusting valuable data to them. You 
can also use this util~y to check disks you suspect have been 
damaged. If you discover that a disk is bad, you can use Copy 
Files to copy those files that are still usable to another disk. 
Then reformat the disk and check it again, using this utility. If it's 
still bad, throw ~ away. 

Change a Disk's Format lets you convert disks from DOS 3.2 
to DOS 3.3, DOS 3.3 to ProDOS, and ProDOS to DOS 3.3. If 
you have older disks created under DOS 3.2 or 3.3, this option 
will convert those disks to the ProDOS format. Some programs 
may not work properly if the disk format is changed. You should 
have no problem converting data files. 

Anotheroption-configure the Serial Ports-is available 
to you on the Advanced Operations menu if you.are using an 
Apple IIc. Refer to Chapter 4 of the "System Utilities" section of 
your Apple lie Owner's Manual for a complete description of this 
option. 
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Finishing Up 

This option is not related to the use of disks and files but 
concerns the use of modems or printers that do not work 
automatically with your Apple IIc. 

No matter how you use your computer, the functions provided 
by the System Utilities can help you keep your disk files easily 
accessible, organized, and protected. As you use your UniDisk 
3.5, you will see the advantages and convenience of having a 
large-capacity, removable disk storage device and, with 
experience, you will also see the advantages of using 
subdirectories to help you more effectively manage your files on 
the UniDisk 3.5. 
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Appendix 8: 

Adding Custom 
Programs 

Manual Installation of 
Your Own BASIC 
Programs 

Many programs can easily be installed with Catalyst using the 
installation instructions in Chapter 4. The program must contain 
a special file to identify it to Catalyst. 

If a program does not contain a Catalyst identification file, Catalyst 
will inform you that it is a custom program when you attempt to 
copy it. Catalyst will copy the program's icon, but none of the 
program files. 

There are really two varieties of custom programs: 

• You (or a friend) wrote it, probably in BASIC. To install your 
program, follow the instructions in this appendix. 

• You bought it. It's a "commercial" program, but it doesn't 
contain a Catalyst identification file. Call the program 
developer (or the company that markets it) for information on 
how to install the program. Quark will generally be unable to 
assist you with the installation of such "third party" software. 

Copy your program onto the high-capacity disk-either a hard 
disk or 3.5-inch disk-you want to run your program from. Use a 
utilities program (Copy Files in System Utilities or in Filer) to copy 
the program's files onto the destination disk. 

1. Drag the BASIC icon from the Catalyst disk onto the disk 
containing your BASIC program. (You don't need to do this if 
the BASIC icon is already present on your destination disk.) 

If you don't have a mouse, use Copy Program ... to copy 
BASIC onto your disk. 

2. Choose Add Program ... from the Miscellaneous menu. 

The first dialog box asks which volume you want to add the 
program to. Select the high-capacity volume that now 
contains your program. Click on the Add ... button or press 
RETURN. 
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The second dialog box lets you provide information to 
Catalyst about your program. Whatever you type will appear 
in the Program Info window once you have completed the 
program installation. 

For information on editing text, see "Editing Text" in Chapter 
6. 

Add a Proqr ar'l 
Proqr ar~ ~olur'le: CATALYST 

Proqr ar'l title: 
Syste~l file: rl C-=AT=AL=Y=ST='B=AS=IC=, ========; 
PrefiH: I 

~r=============~ Proqml path: IL-_________ .....J 

~====:::::!J I 
lm n 

3. Type your program's name. 

Whatever you type replaces Untitled in the highlighted 
title box. 

4. Press TAB to move to the System file box. 

Since CATALYST /BASIC. should be your system file name, 
you don't need to type anything here. 

5. Press TAB to move to the Prefix box. 

If your program is stored in the main directory, you don't need 
to type anything here. Press TAB to move to the Program 
path box. 

If your program is stored in a subdirectory, type the prefix of 
that subdirectory here. Then press TAB to move to the 
Program path box. 

122 Appendix B: Adding Custom Programs 



6. Type the pathname of the program you want to run. 

If you don't type a pathname, Catalyst defaults to STARTUP. 

7. Click on OK or press RETURN when you have completed 
your entries. 

You can't copy your program by dragging it to another disk 
because Catalyst has no way of knowing about all the files your 
program uses. For example, suppose your custom program 
contains three files: STARTUP, X1, and X2. If you tell Catalyst 
that the system path is CATAL YST/BASIC. and the program path 
is STARTUP, Catalyst still has no way of knowing about the files 
X1 and X2. 

Similarly, when you drag the icon for your installed custom 
program into the trash, only the icon is deleted. You must use a 
utilities program (Delete Files in System Utilities or Filer) to 
remove the program files from a disk. 
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Appendix C: 

Catalyst Service 
and Revised 
Product 
Versions 

warranty 
Registration Card 

Service 

Each set of Catalyst disks has its own serial number. Your 
Catalyst disks are unique to you. 

If you find that one of your serial numbers is incorrect (see the 
instructions for checking your serial numbers in Chapter 4), you 
can return your disk to Quark for free reserialization. 

Quark offers free technical support to registered Catalyst users 
only. To qualify as a registered user you must fill out and return 
the Catalyst product Warranty Registration Card included in this 
manual. Otherwise you will be charged a fee for any technical 
support you may require. 

As a registered user, you will also receive information on product 
enhancements, so you will always be able to have the very latest 
version of this program. 

No matter how careful you are, you may eventually need a disk 
fixed. You must return the original Catalyst disk to obtain a 
replacement. 

• A disk with a serial number discrepancy will be reserialized 
free of charge during the first 90 days after purchase. 

• Any disk damaged because of mismanufacture will be 
replaced free of charge during the first 90 days after 
purchase. No warranty service will be provided if Quark has 
not received your Warranty Registration Card. 

• After 90 days, a damaged disk can be returned for recopy or 
replacement. The charge is $10.00 for recopying, $20.00 for 
replacement. Enclose $1 0.00 with your disk to avoid C.O.D. 
and shipping charges. 
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When you return a disk to Quark, please include purchase date; 
problem description; system description (amount of memory, 
peripheral devices attached, cards installed); and Warranty 
Registration Card. 

Return disks to: 

Quark Incorporated 
2525 West Evans, Suite 220 
Denver, Colorado 80219-5554 
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active window 
The front window on the desktop; the window where the next 
action will take place. An active window contains a close box, and 
its title bar is highlighted with horizontal stripes. 

arrow keys 
The four keys at the bottom right of the keyboard. You can use 
the arrow keys to select from lists in dialog boxes. When a 
mouse isn't connected, you can use the arrow keys in 
conjunction with the OPEN APPLE and SOLID APPLE key s to 
move the pointer around on the desktop in the four directions. 

back up 
To make a spare copy of the information on a disk or volume. 
Backing up your disks ensures that you won't lose information in 
case a disk is lost or damaged. 

BASIC 
A popular computer language. The Apple II, ProDOS-based 
dialect of BASIC is included on the Catalyst disk. 

button 
Buttons appear in dialog boxes and are clicked or selected to 
confirm, cancel, or choose an action. See also Cancel button, 
mouse button. 

cache 
To store (traditionally, in a hiding place) for future use. Program 
code caching is possible with Catalyst only if you have an Apple II 
Memory Expansion Card. 

Calculator 
A desk accessory that works like a four-function pocket 
calculator. 

Cancel button 
A button that appears in dialog boxes. Clicking this button, or 
pressing ESC, cancels the current command. 

Catalyst 
A mouse-based program selector for the Apple II and high­
capacity disk drives. 

choose 
To pick a command from a menu. Usually you do this after you 
have selected something for Catalyst to act on. 
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click 
To position the pointeron something, then press and quickly 
release the mouse button. If you don't have a mouse, the 
SOLID APPLE key performs the clicking function of a mouse. 

Clipboard 
The holding place for the text that was last cut or copied. 

Clock 
A desk accessory that displays the current date and time if you 
have a clock chip installed in your Apple. 

close 
To make a window disappear (if it is a desk accessory) or zoom 
back into the icon that represents it (if ~ is a disk window) . 

close box 
A small box on the left side of the title bar of an active window. 
Clicking a close box closes the window. 

command 
A word or phrase, usually in a menu, that describes an action for 
Catalyst to perform. Some commands can be performed by a 
combination of OPEN APPLE or CONTROL with a character key. 
OPEN APPLE-R, for example, represents the command Run 
Program ... . 

CONTROL key 
A key that, when held down while another key is pressed, 
causes a command to be initiated. CONTROL key command 
equivalents are designated in a menu as a solid diamond 
followed by a character key. 

desktop 
Catalyst's working environment--the menu bar and the gray area 
or background on the screen. 

desktop accessories 
Mini-applications available on the Catalyst desktop. Examples 
are the Calculator, Clock, and Puzzle. 

dialog box 
A box containing a message requesting more information from 
you, or letting you make further choices. It sometimes takes the 
form of an alert that beeps and reminds you to do something or 
asks if you are sure you want to proceed. 
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dimmed command 
A command that cannot be chosen. It is dimmed, or gray, in 
contrast to the other commands. 

disk 
A magnetic medium on which the Apple stores and from which it 
retrieves information. Disks can be 5 1/4-inch (floppy disks), 3.5-
inch (UniDisk 3.5) or hard (QC1 0, QC20, ProFile). 

disk drive 
The mechanism that holds the disk, retrieves information from it, 
and saves information on ~ . 

double-click 
To position the pointer where you want an action to take place, 
and then press and release the mouse button. If you don't have 
a mouse, double-click means to press the SOLID APPLE key 
twice in quick succession. 

drag 
To position the pointer on something, and then press and hold 
the mouse button while you move the mouse. When you 
release the mouse button, you have moved the ~em to a new 
location or have confirmed a selection. 

ESC key 
The key at the top left of the keyboard. Pressing it in Catalyst has 
the same effect as clicking the Cancel button. 

file 
A collection of information stored on a disk. 

floppy disk 
A 5-1/4 inch flexible disk used in the built-in disk drive on an 
Apple IIc and in Disk II drives. 

format 
To prepare a disk to receive information, by dividing it into 
sections. Formatting, also called initializing, is done by a utilities 
program. 

hard disk 
A type of disk drive that has a single rigid high-capacity platter on 
which it stores information. Generally a hard disk cannot be 
removed from ~s drive. 
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high-capacity disk 
A disk drive that stores large amounts of information. 

highlight 
To make something visually distinct from its background. An 
item is usually highlighted to show that it has been selected or 
chosen. 

I-beam 
A type of pointer used in entering and editing text. 

icon 
A graphic representation of an object, a concept, or a message. 
For example, Catalyst uses six kinds of icons to represent 
varieties of disks. 

information window 
The window that appears when you select an icon and choose 
Get Info from the File menu. 

initialize 
To prepare a disk to receive information. Also called formatting. 

insertion point 
The point where text will be added. It is represented by a 
blinking vertical bar. The insertion point may be moved to a new 
location by clicking or using the LEFT or RIGHT arrow keys. 

install 
To copy a program with Catalyst onto a high-capacity disk. 

memory 
The place in the Apple where information is stored while you are 
working on n. Temporary memory, called RAM, depends on 
electricity; when the power goes off, the contents of RAM go 
away. 

Memory Expansion Card 
A plug-in card for the Apple lie that lets you expand RAM up to 
one megabyte. The card is also referred to as a "RAM Disk" 
because it behaves like a disk drive as it stores information. 

menu 
A list of commands that appear when you point to and drag the 
menu title in the menu bar. 
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menu bar 
The horizontal strip at the top of the screen that contains menu 
titles. 

menu title 
The word in the menu barthat designates one menu. 

mouse 
A small device connected to your Apple that you roll around on a 
flat surface. When you move the mouse, the pointer on the 
screen moves correspondingly. 

mouse button 
The button on top of the mouse that you press, hold, and 
release to perform various mouse actions. 

open 
To create a window showing the contents of a disk icon. Also, to 
start up (run) a program with Catalyst. 

OPEN APPLE key 
The key to the left of the SPACE bar that is used in combination 
with other keys to perform actions. OPEN APPLE and character 
keys represent some Catalyst commands; OPEN APPLE, SOLID 
APPLE, and the arrow keys are used to move the pointer when 
you don't have a mouse connected. 

paste 
To insert the contents of the Clipboard (whatever was last cut or 
copied) into a text-editing field. 

pathname 
A series of names, separated by slashes (/), that indicate the 
hierarchical "path" to a particular file. Pathnames are used to 
organize file names on high-capacity disk drives for easier 
access. 

~ pointer 
An arrow or other indicator on the screen that tracks the 
movement of the mouse. 

prefix 
A partial pathname that you set using a utilities program. When 
you set a prefix, you can find a group of files in a subdirectory 
more easily and quickly. 
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press 
To position the pointer on something and then hold down the 
mouse button without moving the mouse. 

ProDOS 
An operating system program that controls the way information is 
processed by the computer and stored on disks. 

program 
Instructions that tell the computer what to do. Some programs, 
like Word Juggler, AppleWorks, and MousePaint, let you 
manipulate information or images. Other programs, like System 
Utilities, let you organize and manage disks and the information 
you keep on them. 

program selector 
A type of program that lets you easily move from one program to 
another without restarting your computer or swapping disks 
constantly. Catalyst is a program selector. 

RAM disk 
A plug-in card for the Apple lie that expands the random access 
memory of the computer and behaves like a disk drive. See also 
Memory Expansion Card. 

RESET key 
A key used in combination with other keys (OPEN APPLE and 
CONTROL) to restart the computer without turning the power off 
and on again. Unless you are instructed to do so, you should 
not use the RESET key. 

RETURN key 
A key at the far right of the keyboard, used to indicate 
acceptance of an action. In Catalyst, pressing RETURN is 
equivalent to clicking the OK, RUN ... , COPY ... , DELETE ... , or 
DISCARD .. . buttons in dialog boxes. 

scroll 
To move the contents of a window so that a different part of the 
contents is visible. 

scroll arrow 
An arrow at either end of a scroll bar. Clicking a scroll arrow 
moves the window contents one line. Pressing a scroll arrow 
moves the window contents continuously. 
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scroll bar 
A rectangular bar that may be along the right or bottom edge of a 
window. Clicking on the scroll bar causes the view of the window 
to change. 

scroll box 
The sma" box within a scroll bar. The position of the scroll box 
within the scroll bar indicates the relative position of the window 
contents. 

select 
To designate where the next action will take place. To select, 
you click or drag across information. 

selection 
The information or item affected by the next command. A 
selection is highlighted. 

size box 
A box on the bottom right corner of some active windows that 
lets you expand and contract the window size. 

SOLID APPLE key 
The key to the right of the SPACE bar that is used in combination 
with the OPEN APPLE and the arrow keys to move the pointer 
and select when you don't have a mouse connected. SOLID 
APPLE can also be used with the appropriate character key to 
perform a Catalyst command; it is interchangeable with OPEN 
APPLE for any command that has a keyboard equivalent on the 
menu. 

startup disk 
A disk with which you start up (boot) your computer. The Catalyst 
disk is a startup disk. 

startup program 
A program on a disk that you designate with Catalyst to be the 
startup program, or the one that runs automatically when you 
start up your computer. 

subdirectory 
A special type of file that is used for organizing and grouping 
related files on a high-capacity disk. A subdirectory contains the 
names of other files that are related to each other in some way. 
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title bar 
The horizontal bar at the top of a window that shows the name of 
the window's contents. You drag on a title bar to move the 
window. 

trash 
The receptacle for items you want to remove from the Catalyst 
desktop. The trash removes a disk from the desktop, and 
permanently deletes a program from a disk. 

UniDisk 3.5 
A high-capacity disk drive that lets you store aOOK of information 
per disk. 

utilities program 
A program that lets you manage the information on your disks. 

volume 
An area of data storage that is treated as a separate disk. 

window 
Area on a desktop where information is displayed. Windows can 
be active (indicated by stripes in the title bar) or not, and can be 
moved around on the desktop, sized, and scrolled through. 
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Index 

A 
About Catalyst. .. 

command 92 
disk serial numbers 54 

active window 31 -32,47-48 
Add Program .. . command 100 
adding custom programs 121 
Apple menu 92-94 
Apple IIc equipment 14-16 
Apple lie equipment 14-16 

8 
backing up disks 103 

See also copying disks 
Backup II 61 , 103 
BASIC programs See program(s) 
buttons 29-30,46,83 

C 
Calculator 92 
Catalyst 

features 13 
Master disk 15,17 

checking serial numbers 54 
programs on 102-103 

quitting 65, 97 
returning to 63 
starting up 15-16 
System program 60,74 

Change Desktop command 93 
Clear command 98 
Clear"Startup command 64-65,75, 99 
clearing startup programs 64-65,75,99 
clicking 

with mouse 22, 23 
without mouse 38 

Clipboard 98 
Clock 93 
close box 30,47 

selecting with mouse 23 
selecting without mouse 39 

Close command 96 
closing windows 32,48, 77,96 
command 13,28 
commercial programs 76, 95 
CONTROL key 27, 44 
Copy command 98 
Copy Program ... command 75,101 
copy protection 60 
copying 

Catalyst System program 60 
disks 78 
files 115 
programs 23,56-60, 75, 101 
with Quick Copy 61,66-67, 102 

custom programs 
adding 100,121-123 
deleting 89 
Program Info window for 76, 95 

Cut command 98 

o 
data files 88 
Delete Program ... command 101 
desktop 13, 16, 88 

accessories 92-94 
file 74 

destination disk 56 
dialog box 90 

editing text in 90 
using with mouse 29 
using without mouse 46 

Discard Disk .. . command 101 
disk(s) 

Catalyst Master 15, 17 
changing 61,99 
copy protection 60 
copying 78 

with Quick Copy 61 , 66-67, 102 
Disk II 16, 80 
ejecting 97 
formatting 75 
hard 81 
installing programs on 56-60 
names 79, 109 
removing contents of 88 

with mouse 25-26 
without mouse 40, 42-43 
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renaming 61, 78 
saving information on 78 
switching 61, 99 
UniDisk3.S-inch 1S,79-80 

disk icon(s) 74 
dragging 

with mouse 24, 25 
without mouse 40,42 

opening 
with mouse 24 
without mouse 41 

selecting 
with mouse 23 
without mouse 39 

Disk II disk 16, 80 
Disk Info window 76, 95 
double-clicking 

wijh mouse 22, 24 
without mouse 38 

dragging 
a window 

with mouse 32 
without mouse 48 

wijh mouse 22, 23-26 
without mouse 38,40-41 ,42 

duplicating disks 116 

E 
Edit menu 97-98 
editing text 90-91,97-98 
Eject command 78, 80, 97 
ejecting 3.S-inch disks 80,97 

F 
File menu 94-97 
Filer 61, 78, 88, 102, 121 
files 

copying 115 
deleting 115 
locking 116 
managing 94-97, 102, 108 
renaming 115 
unlocking 116 

formatting disks 75, 116 

G 
Get Info command 76-77,95 

H 
hard disk 81 
Hide RAM Disk command 82-83, 100 

icon(s) 13, 17,88 
getting information about 76 
opening 

with mouse 28-29 
without mouse 45 

selecting 
with mouse 23 
without mouse 39 

RAM disk 82, 100 
inactive window 31, 48 
initializing disks 75 

See also formatting disks 
installing programs 56-60, 84 

K 
keystroke shortcuts 46 

M 
Master disk See Catalyst Master disk 
Memory Expansion Card 76, 82 
menu 13,16,24 

dragging on 
with mouse 24 
without mouse 40 

viewing 
with mouse 28 
without mouse 44 

menu bar 13 
use with mouse 26 
use without mouse 43 

Menu item 
selecting with mouse 28 
selecting without mouse 45 

Miscellaneous menu 99-101 
MousePaint 61, 102 
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moving a pointer 

o 

with mouse 22 
without mouse 38 

OPEN APPLE key 27,38,43,58,62,63,68, 
69,80 

Open command 28-29,45,94 
opening 

p 

by double-clicking 
with mouse 24 
without mouse 41 

with Open command 28-29, 45,94 
RAM disk icon 82 

Paste command 98 
path name 110 
pointer 16 

moving with mouse 22 
moving without mouse 38 

prefix 11 0-111 , 118 
printing the screen 91 
program(s) 

BASIC 61,121 -123 
Catalyst System 60, 74 
commercial 76,95,121 
copying 23,40,56-60,75,101 
custom 76,88,95, 121 
deleting 101 
getting information about 68 
installing 56-60 

with mouse 57 
without mouse 58 

on Catalyst disk 61, 102-103 
removing 69,88, 101 

with mouse 23,25 
without mouse 40,42 

running 62,96 
starting up 13, 24, 41 

program icon(s) 
changing position of 69 
dragging 

with mouse 23,25 
without mouse 40,42 

opening 
with mouse 24 
without mouse 41 

rearranging 69 
selecting 

with mouse 23 
without mouse 39 

Program Info window 68, 76-77, 83-84, 95 
Puzzle 94 

Q 
Quick Copy 61,66-67,79,102 
Quit command 97 
quitting Catalyst 65,97 

R 
RAM disk 82-84, 100 
RAM disk control settings 83-84,89 
RAM disk icon 100 

opening 82 
selecting 

with mouse 23 
without mouse 39 

removing 
disk contents 24, 25, 88 
programs 23,25,69,88,101 

renaming disks 61,78 
returning to Catalyst 63 
Run Program ... command 62-63, 96 
running a program 62-63, 96 

S 
saving information 78 
screens, printing 91 
scroll bar 31,33,47,49 
scroll box 34, 50 
scrolling windows 33,49 
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selecting 
by clicking 

with mouse 23 
without mouse 39 

commands 
with mouse 28 
without mouse 43,45 

icons 23,39 
with mouse 22-23,28 
without mouse 38-39 
windows 23,39 

serial numbers on Catalyst disks 54 
Set Startup command 64-65,75,99 
setting startup programs 64-65, 75,99 
Show Clipboard command 98 
Show RAM Disk command 82-83, 100 
size box 30,47 
SOLID APPLE key 27,38,43 
source disk 56 
starting up Catalyst 15 

on Disk II 16 
on UniDisk 3.5 15 
with RAM disk 84 

starting up programs 13, 24 
startup programs 

bypassing 99 
clearing 65, 75 
setting 64-65, 75 

subdirectories 109-111, 117 
Switch Disks command 80-81, 99 
System Utilities 61,78,102,107-119,121 

T 
title bar 30,47 
Trash 17,25,42,88 
Trash icon 25,42, 88 

U 
Undo command 98 
UniDisk3.5 15,79-80,107-109 
UniDisk 3.5-inch disk(s) 

copying 78,79,102 
ejecting 80,97 
formatting 108, 116-117 
starting up Catalyst on 15 
using System Utilities with 107-119 

V 
volumes 109 

W 
window(s) 30-34,47-50,89 

activating 
with mouse 31 
without mouse 47-48 

active 31,47-48 
changing size of 

with mouse 33 
without mouse 49 

closing 
with Close command 96 
with mouse 32 
without mouse 48 

Disk Info 76,95 
dragging 

with mouse 32 
without mouse 48 

inactive 31,48 
making active 

with mouse 31 
without mouse 47-48 

moving 
with mouse 32 
without mouse 48 

Program Info 68, 76, 95 
scroll box with 34,50 
scrolling 

with mouse 33 
without mouse 49 

selecting 
with mouse 23 
without mouse 39 

138 Index 



More Quark products 
for you and your Apple. 

See your favorite dealer for more information about these 
and other products from Quark. If you don't have a favorite 

dealer, but would like one, just callI (800) 543-7711. 
We'll fix you up. . --------------------

Software for your Apple lIe or Apple Ilc. 
From Quark Incorporated. 

WORD JUGGLER'" 
word processor 

Word Juggler is an easy-to-use, business-level word processor for your 
Apple lie or Apple lie. There's virtually nothing to memorize, because a 
special keyboard command strip and Quark's unique keycap decals* 
identify principal editing and formatting functions. A stand-up, quick 
reference card is also included. 

The program comes with the Lexicheck™ spelling checker, which has a 
50,000 word dictionary-and Quark's exclusive Word Guess Plus™ feature . 
You also get a special Telecommunications Mode, with four user-definable 
protocols, plus automatic dialing and logon. 

U.S. suggested retail is only $99. 

There's an Educational Edition of Word Juggler, too; with versions for 
both student and teacher. It's ideal for Grades 5 through 12, as well as for 
college level classwork, because it's professionally designed for the unique 
needs of both educators and students. 

Quark's Educational Marketing Manager has complete details. 



T E R MIN US'" 
communications program 

Terminus is a telecommunications program designed to stand 
alone-with its built-in text editor-or work as an accessory to Word 
Juggler. The program lets you communicate with on-line data bases, such 
as THE SOURCE,** as well as with other computers. 

One keystroke sends files created by any program for the Apple lIe, 
Apple lIc or Apple III. 

Terminus is ideal for electronic mail and other communications 
applications. The program allows you to define protocols necessary for 
communicating with as many as 15 different systems. And each protocol 
provides 26 keyboard macros. U.S. suggested retail is just $89. 

Hard disks for your Apple lIe, Apple IIc, 
Apple III or Macintosh. 

From Quark Peripherals, Inc. 
Our affiliate company, Quark Peripherals, Inc., offers you two 

powerful hard disk products, both of which work on the Apple lIe, Apple lIe, 
Apple III and Macintosh. A special switch on the back of each machine lets 
you set your hard disk for the computer you are using. 

QClO™ is a 10 Megabyte hard disk, with a suggested retail price of 
just $1295. 

QC20™ offers you 20 Megabytes of storage for only $1795. 

Both hard disks have a sophisticated volume management system and 
password protection capabilities. 

*Replacement keycaps, which identify principal editing functions are available from Quark, 
or through your dealer, for only $29. These are actual Apple keycaps, custom-printed with 
Word Juggler commands, to give your keyboard the clean, professional look of a dedicated 
word processor. These replacement keycaps are available for the Apple lIe and many 
Apple IIc personal computers. Your dealer will have the details. 

**THE SOURCE is a service mark of Source Te\ecomputing Corporation, a subSidiary of Reader's Digest 
Association, Inc. 



Quq!..~'" 
WARRANTY 
REGISTRATION 
2525 West Evans, Suite 220 

Denver, CO 80219-5554 

ATIN: Warranty Service Department 

PLACE 
Sf AMP 
HERE 



To become a 
Re~istered User, 
and to qualify for 
free technical 
support for this 
product, you must 
first fill-out and 
return this Warranty 
Re~istration Card. 

S~~ested retail value $34.95 
when included with 
Apple's UniDisk 3.5. 

Serial Number ____ ___ (Invalid without this number.) 

WARRANTY REGISTRATION 
NAME ___________ _ 

ADDRESS __________ __ 

CITY ___________ _ 
Sf ATE/ZIP __________ _ 
PHONE(~ _ __________ _ 

PURCHASED FROM ______ _ _ 

CITY & Sf ATE _________ _ 
PRODUCTNAME ________ _ 

DATE PURCHASED _______ _ 

What is your intended use for this product? 

What computer(s) do you use? 
Apple lIe _ Apple lIc _ 

SYSTEM CONFIGURATION 

If you use a hard disk which brand do you use? 

StoraQe capacity? MB 
Doyou have an Apple II memory expansion card? 

What brand of printer do you have? __ _ 

What Rind of printer interface do you have? 
o SERIAL 0 PARALLEL 
What is the brand name of your interface?_ 

Other equipment: _______ _ 

What computer maQazines do you read (in order 
of preference)? ________ _ 

What software would you liRe to see in the fu ture? 

Memory capacity D 64K D 128K Comments and SUQQestions ___ _ _ 
Quantity of floppy disR drives ____ _ 
Drive MfQ? _______ ___ __ 



CAT A L Y S T '" Program Selector from Quark. 

Catalyst is a productivity tool which lets you: 
• Copy (install) your frequently used programs onto a high capacity disk. 
• Switch between your programs with the click of a mouse. 
• Use built-in desk accessories, such as a calculator or clipboard. 

~ '\., 
Filer 
~ 

BacKup II 

With Catalyst, you can load such best-selling 
ProDOS programs as AppleWorks and Word 
Juggler onto your Quark QC10 or QC20 hard disk, 
Apple UniDisk 3.5, Apple ProFile, or other storage 
system. And change between them without having 
to re-start your computer, fumble with diskettes or 
deal with long and confusing file names. 

You simply insert Catalyst when you turn on your 
machine and you may never have to touch another 
disk all day. You save time and desk space. And 
eliminate the risk of misplacing or damaging your 
original disk. 

3V; " program disk version 

~ 
BASIC 

To use Catalyst, you need: 
• Apple lIe or Enhanced 128K Apple IIe. 

• Monitor. 
• . Disk II or UniDisk 3.5. 

• Mass storage device (hard disk or Apple UniDisk 
3.5). 

Quark strongly recommends you use a mouse 
with this product. . 

Quark Incorporated, Denver, Colorado 

Marketing Number D2D0114 


